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1. Introduction

This chapter provides an overview of the VP-1231-CE7 and its components, and introduces the
fundamental concepts for user familiar with the VP-1231-CE7.

The VP-1231-CE7 is the new generation Windows CE 7.0 based PAC (Programmable Automation
Controller) of ICP DAS. Each VP-1231-CE7 is equipped with a Cortex-A8 (1.0 GHz) CPU running a
Windows CE 7.0 operating system, a variant of input/output ports (VGA, USB, Ethernet,
RS-232/485), and 3 expansion 1/0 slots that can be used to integrate high performance I-8K
(parallel-type) and 1-87K (serial-type) series I/O modules.

Its operating system, Windows CE 7.0, has many advantages, including hard real-time capability,
small core size, fast boot speed, and interrupt handling at a deeper level, achievable deterministic
control and low cost. Using Windows CE 7.0 in the VP-1231-CE7 gives it the ability to run PC-based
Control software such as Visual Basic.NET, Visual C#, Embedded Visual C++, SCADA software, Soft
PLC ...etc.
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1.1. Features

The VP-1231-CE7 offers the most comprehensive configuration to meet specific application
requirements. The following list shows the hardware and software features designed to simplify

installation, configuration and application.

Hardware Features

J Powerful CPU module
o Cortex-A8 1.0 GHz CPU

. Memory Size:
- SDRAM (512 MB)
- MRAM (128 KB)
- Flash (256 MB)
- FRAM (64 KB)
microSD card (support up to 32 GB)

* VGAPortx1, USB 2.0 port x 1, Series port (RS-232/RS-485) x 2
. 64-bit Hardware Serial Number
*  Dual Watchdog Timers

. Operating Temperature: -25~ +75 °C

Software Features

Windows Embedded Compact 7.0
*  JavaScript and VBScript

*  SQL Compact Edition 3.5

*  .NET Compact Framework 3.5

*  Remote Display

J Rich Software Solution — SDK for Microsoft Studio 2008
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1.2. Specifications

The table below summarizes the specifications of the VP-1231-CE7.

Models VP-1231-CE7

System Software

oS Windows CE 7.0

.Net Compact Framework 3.5

FTP Server, Web Server (Supports VB script, JAVA script),
Embedded SQL Server

SDK Provided DIl for

Embedded Service

English, German, French, Spanish, Russian, Italian, Korean,
Multilanguage Support S ) o ]
Simplified Chinese, Traditional Chinese

CPU Module

CPU Cortex-A8 (1.0 GHz)

SDRAM 512 MB (DDR3)

MRAM 128 KB

Flash 256 MB

EEPROM 16 KB

microSD microSD socket with one microSD card

RTC (Real Time Clock) Provide second, minute, hour, date, day of week, month, year
64-bit Hardware Serial Number Yes, for software copy protection

Dual Watchdog Timers Yes (0.8 second)

3 Dual-Color LEDs (PWR, RUN, LAN1, L1, L2, L3; L1 to L3 for

user programmable)

LED Indicator

Rotary Switch Yes (0 to 9)

VGA & Communication Ports

VGA Resolution 640 x 480

Ethernet RJ-45 x 1, 10/100/1000 Base-TX

usB USB2.0x2

coOmM 0 For I-87K series modules in slots

COM 2 RS-485 (D+, D-; self-tuner ASIC inside); 2500 Vpc isolated

e RS-232 (RxD, TxD, CTS, RTS, DSR, DTR, CD, Rl and GND);
Non-isolated

VP-1231-CE7 User Manual, v1.0.0 Page: 8

Copyright © 2016 ICP DAS Co., Ltd. All Rights Reserved. <] E-mail: service@icpdas.com




Models VP-1231-CE7

1/0 Expansion Slots

Number of 1/0 slots 3

Supported types of I/0 modules I-8K and I-87K series I/O Modules

Dimensions (W x H x D) 182 mm x 158 mm x 125 mm
Ingress Protection Front panel: IP65
Installation Wall mounting

Environmental

Operating Temperature -20°Cto+70°C
Storage Temperature -30°Cto + 80 °C
Ambient Relative Humidity 10 % to 90 % RH (non-condensing)

Input Range +10 Vpcto +30 Ve

Redundant Power Inputs Yes

Isolation 1 kv

Capacity 2.5A, 5V supply to I/O expansion slots

Consumption 7.2 W (0.3 A @ 24 Vp()
VP-1231-CE7 User Manual, v1.0.0 Page: 9
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1.3. Overview

The VP-1231-CE7 is equipped with several interfaces and peripherals that can be integrated with

external systems. Here is an overview of the components and its descriptions.

Front View Side View

LED Indicators  Touch Screen Rotary Switch

Programmable Function Keys

Back View

=,
L

I/O Slots

Power Input and
Frame Ground

@ Ethernet Port

COM2 (RS-485)
il H——1 2y

USB Port COMS3 (RS-232)
Mic-in and Earphone-out
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e LED Indicators

The VP-1231-CE7 has 3 Dual-Color LED indicators. The details of these LED indicators are as
follows:

‘LED Indicator ‘Color Status ‘Description

Red On
L1/L2/L3 LED indicators controlled by user Program.
Red Off
Green On System booted and ready.
Green Off BIOS failure.
RUN
o System memory mapped out, formatted or
Green Blinking
defragmented.
PWR Green On System has power applied to it.
Green Off System is not powered on.
Green On Link between system and network.
LAN1 Green Off Network disconnected.
Green Blinking Network Access.

e Touch Panel

The VP-1231-CE7 is equipped with a touch panel to the display panel.

® Programmable Function Keys

The VP-1231-CE7 provides support for keyboard input. The F1 to F6 function keys can be

programmed by the user.

e Rotary Switch

Rotary Switch is an operating mode selector. The VP-1231-CE7 has several operating
modes, for more detailed information about these operating modes. Please refer to
“2.3 Configuring the Boot Mode”
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e 1/0 Slots

The VP-1231-CE7 has 3 1/O slots that can be used to integrate high performance parallel 1/0
modules (high profile |-8K Series) or serial I/O modules (high profile I-87K series).

e Power Input and Frame Ground

The VP-1231-CE7 has a terminal with 3pins, there are 2 pins for power input and a pin for frame

ground as follows:

+10- 30 VDC
PWR—l PGND [T
| F.G

A

Power Input  Frame Ground

o Ethernet Port

The VP-1231-CE7 has an Ethernet port that can be used to connect that can be used to connect

the router to the Internet or to other devices.

® Mic-in and Earphone-out

The VP-1231-CE7 has a microphone and an earphone jack to the input and output of sound

system.

e USB Port

The VP-1231-CE7 has a USB 2.0 port that can be used to connect the USB devices such as mouse,

keyboard or an external USB hard drive.
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e COM2

COM2 port provides a connection to external RS-485 devices. The COM2 has 2 pins, as follows:

Baud Rate: 115200, 57600, 38400, 19200, 9600, 4800, 2400, 1200 bps
Data Bits: 7, 8

Parity: None, Even, Odd, Mark (Always 1), Space (Always 0) D-— mﬂ — D+

Stop Bits: 1, 2

FIFO: 16 bytes R5-485

e COM3

The VP-1231-CE7 has one standard RS-232 serial communication interface port, COM3 (9-pin

Sub-D plug connector). The details of this Pin assignment are as follows:
Port Type: Male
Baud Rate: 115200, 57600, 38400, 19200, 9600, 4800, 2400, 1200 bps

Data Bits: 5, 6, 7, 8

Parity: None, Even, Odd, Mark (Always 1), Space (Always 0)

Stop Bits: 1, 2

FIFO: 16 bytes
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1.4. Dimensions

The diagrams below provide the dimensions of the VP-1231-CE7 to use in defining your enclosure

specifications. Remember to leave room for potential expansion if you are using other components

in your system.
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1.5. Companion CD

This package comes with a CD that provides a collection of the software utility, documentation,
drivers, demo program and application. The CD contains several subdirectories located in \VP-x231

directory. All of them are listed below.

CD:\VP-x231\

Backup

i

The files package for each release.

”H

The demo programs for examples of use in the application.

The technical support documents for installation, operation,

maintenance, development and application.

L

The recovered files stored on the micro SD card, that can be used to
boot and recover the system from micro SD card.

0S_image

|

The files and related information for OS releases and technology.

|

The tools and utilies for operation with PC.

I

The sources for development and application in your application.

I

The tools and drivers related to System_Disk that install on VP-1231-CE7.

Update

|

The installation packages related to VP-1231-CE7.
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2. Getting Started

This chapter provides a guided tour of the VP-1231-CE7 installation and configuration that
describes the steps needed to download, install, configure, and run the basic procedures for user
working with the VP-1231-CE7 for the first time.

Before starting any task, please check the package contents. If any of the following package

contents are missing or damaged, contact your dealer, distributor.

Adapter

VP-1231-CE7 and I/O Touch A microSD Card and A microSD Software
socket x 3 Panel to SD Adapter Utility CD

RJ-45 Waterproofing Kit Screw Panelclipx 4 M4 x 30L

Driver Screw x 4
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2.1. Mounting the VP-1231-CE7

Before you work with the VP-1231-CE7, you should have a basic understanding of hardware
specification, such as the dimensions, the usable input-voltage range of the power supply, and the
type of communication interfaces.

For more information about the hardware details, see section 1.2., “Specifications.”

For more information about the hardware dimensions, see section 1.4., “Dimensions.”
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2.1.1. Removing the Slot Cover

.
Frlastic Wrap
1

The VP-1231-CE7 has a slot cover to protect the internal
components from damage during shipping. Before starting
any installation, please first remove the slot cover.

Step 1: Hold the top of VP-1231-CE7

Step 2: Pull the plastic wrap

The slot cover has
been removed

VP-1231-CE7 User Manual, v1.0.0 Page: 18

Copyright © 2016 ICP DAS Co., Ltd. All Rights Reserved. E-mail: service@icpdas.com




2.1.2. Installing Expansion 1/O Sockets

The case (a socket and a top case) is included in the package.
Before inserting the 1/O modules you first need to install the
expansion |/0 socket.

Step 1: Take the I/0 socket out from the case

Step 2: Padlock the bottom of the I/0
socket into the VP-1231-CE7

Step 3: Slide the socket into the
VP-1231-CE7 until it clicks
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2.1.3. Inserting and Wiring the 1/0 Modules

VP-1231-CE7 supports various types of I/0 expansion modules for interfacing many different field
devices. For more information about I/O expansion modules, please refer to:
http://www.icpdas.com/products/PAC/winpac/io support list.htm

Step 1: Hold the 1/0 module vertically and align the socket

Step 2: Carefully press the I/0 module onto the socket
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http://www.icpdas.com/products/PAC/winpac/io_support_list.htm

2.1.4. Mounting the Waterproof

The VP-1231-CE7 is equipped with an IP67 waterproof connector to withstand contaminant in
dusty environment and immersion in water and corrosive elements.

Stepl__ Step 2 _ ,
o, Ll*l Neol Ile

Sep3 Step 4 ‘—_.”
O °’ : O

Step 5 Ste 6
L3 madd

Step 7 Step 8

Step 10
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Step 15
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2.1.5. Mounting the VP-1231-CE7

Panel thickness

The VP-1231-CE7 can be mounted on a panel of maximum thickness
upto 12 mm ™~

12 mm. Adequate access space can be available at the rear of the
instrument panel for wiring and servicing purposes.

Tips & Warnings

A To ensure proper ventilation for the VP-1231-CE7,
leave a minimum of 50 mm space between the

top and bottom edges of the VP-1231-CE7 and
the enclosure panels.

Step 1: Prepare the panel and cut the hole to the
specified size

136 =1

Step 2: Attach the VP-1231-CE7 to the cut-out hole

Unit: mm
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Step 3: Insert the panel mounting clips into the upper and lower ventilation holes

Step 4: Screw the panel mounting clips to the panel.

Tips & Warnings

A Recommended Screw Torque: 3.4 ~ 4.5 kgf-cm.

VP-1231-CE7 User Manual, v1.0.0 Page: 24

Copyright © 2016 ICP DAS Co., Ltd. All Rights Reserved. <] E-mail: service@icpdas.com




2.2. Deploying a Basic VP-1231-CE7 System

The VP-1231-CE7 provides a variety of communication interface to suit a range of application. Here

is a simple application for using the VP-1231-CE7.

Step 1: Connect the positive terminal (+) of the power supply to the terminal PWR1/2
and the negative terminal (-) of the power supply to the P.GND

Step 2: Connect the USB mouse or the USB keyboard to the USB port

Step 3: Connect the monitor to the VGA port

Step 4: Connect to PC or the laptop to the LAN port via an Ethernet switch

+10~+30VDC

Y e JE AR |£§ﬁm‘“j ||
Audio Keyboard PC
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2.3. Configuring the Boot Mode

The VP-1231-CE7 has several operating modes, which can be selected by a rotary switch.

The table below lists the operation modes available with the VP-1231-CE7.

Position Operating Mode

0 Normal mode (Default)

Safe mode

Debug mode

OS update mode by Ethernet

OS update mode by Micro_SD

1
2
3
4 Reserve
5
6

Reserve (OS Development Mode)

7~9 User Mode

The following is a brief introduction of these modes.

Normal Mode (Default mode)

Normal mode is the default mode of operation and the one you will use most of the
time. Use this mode for more tasks and configurations. Programs also are executed in
this mode.
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Safe Mode

Safe mode is a trouble shooting. The mode loads the minimum required device
drivers and system services to boot the VP-1231-CE7.

If you have malicious software or a program caused the VP-1231-CE7 cannot be boot
or run the normal mode, you can boot in safe mode to solve the problem.

Debug Mode

Debug mode is a special environment in which program debug functions can be used
in addition to normal system functions.

Debug mode is unsupported.

OS Update Mode

OS update mode is a way used to update OS. For more information on updating the
VP-1231-CE7 OS image, please refer to section 6.1. OS updates

Reserve — OS Development Mode

The positions 4, 6, of rotary switch are reserved for OS development.

User Mode

The positions 7, 8, 9 of rotary switch are reserved for user’s applications.

When VP-1231-CE7 is boot with one of these positions, it is boot at normal mode.

User’s application can check the position of the rotary switch position to run at
different mode.
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2.4. Changing the User Interface Language

The Regional and Language Settings is a Windows CE functionality that allows users to change the

VP-1231-CE7 user interface with your native language.

Step 1: Click Start menu, point to Settings, click Control Panel, and then click Regional
Settings

-Fj Prograrns ’
'{? Faviorites r
D Documents
B Settings

B Contral Panel
(}, Metwork and Dial-up Connections
E Taskbar and Start Men...

gicnal
Settings

Regional and Language Settings

Regional Settings Lser Intetface Language I Input Language |

-Your locale

The locale option affects how some programs format numbers, currency,
time and dates,

Customize...
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Step 2: Click User Interface Language tab, choose to your local language, and then click

OK button

-User Interface Language

Regional and Language Settings m

| Regional Settings | User Interface Language | Input Language |

and alerts.,

The option will determine the language used for the menus, dialogs

English (United States) El

French I{rar'u:e]l
German (Germnarny)

Ttalian (Ttaly)

Portuguese (Brazil
Spanish (Spain - International Sort)

Step 3: Double-click the PAC Utility on the desktop, and then reboot the VP-1231-CE7 for

changes to take effect

Double-click
the PAC Utility
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PAC Utility [1.2.1.4]

iiE Help

Save
Save and Reboot
Reboot

Restare Utility Default Settings
Exit

j";l'
onfig I Metwork |,5‘
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2.5. Using PAC Utility to Manage the VP-1231-CE7

The PAC Utility is a collection of the VP-1231-CE7 system tool that allows users to manage and
configure the VP-1231-CE7 quickly and easily.

For more detailed information on PAC Utility applications, please refer to “3.1. PAC Utility”

Step 1: Double-click the PAC Utility on the desktop

Step 2: Configure IP address (DHCP), FTP Server, Auto Execution files..., etc

Efile Help

General | General2 ID\spIay I 1P Config | Netwark IDE\HEE! Information I Autn Execution IRDtary Exd Al I 4

E—

Access | Login

% 4

Double-click

FTP @ Enzble () Disable

Allow Anorymous @ Enable (O Disable

Set FTP default download directory to:

the PAC Utility L [ T
My Device

- Netwaorl:
SetHTTP do| - system_disk

wrindowsiyw] - Recycled Apply |
i~ Application Data

My Recent Docurments
My Documents
Program Files

e Aindoes
Cancel I Ok
Step 3: Reboot the VP-1231-CE7
PAC Utility [1.2.1.4]
iﬁﬁ Help 7
Save ﬁ’
Save and Reboot prfig | Metwark 3
Reboot {'I
— L
2
Restore Litility Default Settings £
Exit {
AC Uty
Ty
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2.6. Using DCON Utility Pro Configure 1/0 Modules

DCON Utility Pro allows users to configure and manage the 1/0O modules via Ethernet or serial ports
(RS-232/RS-485).

Step 1: Double-click the DCON_Utility_Pro on the desktop
g

.8

Double-click the
DCON_Utility_Pro

Step 2: Click the % button
DO 0 (.00 X
[ ]
430 R EE

Start Address [0 | End Address
ID

IAddr... |Baud Rate IChecka... |Format|5ta1u5 |Descriptiom

4]
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Step 3: Configure the communication settings

COM Port Option

COM Port Timeout
] 300 ms
comM1 locksum | Format
COM2 pcksur | l
COM3
O B2 [JE&1 [oe1

(8]4 Cancel

Tips & Warnings

A The COM port settings for expansion I/O modules are listed below.

COMO [Backplane] <€

=

1,‘

\\i'l' 1T 1| 1T 1| Il 11T 11l -1]_/}

com2/3 <€

For more information on these COM port selections, please refer to the

specification of the pin assignments in section 1.3. Overview
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Step 4: Click the E button

Step 5: Click the module name to configure the I/0 module

DCON UtilityBeo CE ¥ 2.0.0.5

DEE3E
Start Address El Erd Address

Addr...J Baud Rate |Check5... IFormatI Stahus IDescription
u 5200 Disable MLE, L [CCOMIB*AL (Universal RTL

9v015

97015Mirmware[B209]

Configuration |.£\I | Abaut|

Protocol IMIT*) |DCON E|
Address U—E [00H]
Baud Rate(NIT*)  |115200 =
Parity (INIT*) {1,2, 1-Mone Parity 5]
Checksum(INIT*)  |Diszble =
< Analog Format Ohms =
[ 60750 Hz |5DHZ |
COM:O[MN,8, 1] |f Save Configurations to the File

‘ Write Configurations to 1/0 Module

Response Delay 0 ms

Exit |
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3. Tools and Tasks

This chapter provides a brief introduction of theVP-1231-CE7 service tools and its benefits.

There are several tools and utilities built-in and designed for use with VP-1231-CE7. Some of these
are pre-installed on VP-1231-CE7 and can work directly on VP-1231-CE7, and some of these are
supporting tools and can help you to manage the VP-1231-CE7 remotely on a PC.

The following tools are pre-installed on VP-1231-CE7 and can work directly on VP-1231-CE7 that
can be found on the CD that was provided with the package or by downloading the latest version
from ICP DAS web site.

CD:\vp-x231\System_Disk\Tools\
http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/system_disk/tools/

- .
s e too
- T
| e
T
B ot Disisy
B nirocon
— T
T
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3.1. PAC Utility

PAC Utility is a collection of software applications that enable management and configuration of
VP-1231-CE7 system and features.
PAC Utility is subject to change

PAC Utility [1.2.1.4] ! E

- General | Generalz I Dizplay IIF' Canfig INetwcurk IDevice Infor matian Ihub:u Execution IRDtary Exg 1] ¥

Welcorme to use PAC Uitility
This tool will help you easy o
Lse PAC CE series.

Task Bar setting:

[ &wuto Hide

PAC Utility

[ alhways On Tap

HIVE Registry:
@ Auto Save Ta Flash (Default)

et : (O Maunal Save To Flash

Backplane Battery [7] Enable &utorun in plugging LSE Disk
Batteryl : Ok Battery2 : Ok [[] Enable &utorun in plugging Micra S0

RTC Battery

Canfigure the synchronization with a time server | Configure | | Backlight Setting

The PAC Utility includes the following menu bars and property tabs.
All of these functions will be explained later.

Menu bar Property Tab

File General

Help General2
Display
IP Config
Network

Device Information

Auto Execution

Rotary Execution
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3.1.1. Menu Bar -File

iﬁﬁ Help

Save
Save and Reboot
Reboot

Restare Utility Default Settings
Exit

The menus use to How to use
Reboot Restarts the VP-1231-CE7
Restore Default Settings Restore the VP-1231-CE7 settings to its default.
Exit Exits the PAC Utility.
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3.1.2. Menu Bar - Help

Ahout PAC Utility

PAC Utility
Yersion: 1.2.0.5

Copy Right (c) 2003, ICPDAS Co., LTD.
All Rights Reserved, PAC Utility and the
PAC Utility logos are rademarks of
ICPDAS,

P&C Windows CE; en-US)

The menus use to How to use
About Displays a dialog box with information about PAC Utility,
including the current version and copyright information.
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3.1.3. Property Tab - General

The General tab provides functions to configure the task bar, check the status of the battery..., etc.

PAC Utility [1.2.1.4]

File Help

General | General2 I Display I IF Config I Metwork I Device Information I AL Execution IRDtary Exe 4| F

Welcome o use PAC Utility
This tool will help you easy to
Lise PAC CE series,
PAC Utilit Y Task Bar setting:
[ &uto Hide

[ sbways On Top

HIYE Reqgistry:
) Auto Save Ta Flash (Defaulf)

{3 Maunal Save Ta Flash

Backplane Battery [7] Enable Autarun in plugging USE Disk
Batteryl : Ok Battery2 : Ok [] Enable Autarun in plugging Micro SO

RTC Battery

Configure the synchronization with a time server | Configure | | Backlight Setting |

The tab use to | How to use

Lock or Auto-Hide | Auto-Hide the taskbar:

the taskbar Select the Auto Hide check box.
Lock the taskbar:
Select the Always On Top check box.
Auto save or Auto save to flash:
manual save to Select the Auto Save To Flash (Default) check box.
flash Any changes made to the VP-1231-CE7 will be saved and only take effect

after the VP-1231-CE7 reboots.
Manual save to flash:

PAC Utility [1.2.1.4]

== Help
Select the Manual Save to Flash
check box. Save and Rebaoaot
Reboot
Any changes made to the
VP-1231-CE7 will be saved by Restare Utiity Default Settings J}
clicking the Save and Reboot from M
File menu.
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The tab use to ’ How to use

Enable USB autorun Select the Enable Autorun in plugging USB Disk check box.

Enable microSD auotrun This item is temporarily unavailable.

Automatic synchronization | Refer to the Appendix A.2. How to configure the service for

of system time automatically synchronizing with the internet time server.

Adjust the backlight Move the slider to the left to decrease the brightness or move the
slider to the right to increase the brightness, and then click the
Save the settings button.

Backlight_Brightness_Setting
'

Brightness value: 0

Save the settings
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3.1.4. Property Tab — General2

The General2 tab provides functions to specify the name of the USB disk.

PAC Utility [1.2.1.4] _10
[ File_Help |

General || General2 | Display l IF Config | Network l Device Information l Auto Execution I Rotary Exe_{ | »

Naming the CF Card and USB Hard Disk

USBE Hard Disk: |USB_Disk |

Set

The tab use to How to use

Specify the name of the USB disk Enter a name in the USB Hard Disk: field
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3.1.5. Property Tab — Display

The Display tab provides functions to configure the monitor settings.

Screen resolution: Screen refresh rate:

Less I M+lare: EI

640 by 480 pixels

The tab use to _How to use

) Move the slider to the left to decrease the resolution or move the
Adjust the screen ] ) ) ) ]
) slider to the right to increase the resolution, and then click the Apply
resolution
button.
Change the screen Select the desired refresh rate from the Screen refresh rate
refresh rate drop-down list, and then click the Apply button.
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3.1.6. Property Tab - IP Config

The IP Config tab provides functions to configure either DHCP (Roaming) or manually configured
(Static) network settings and to monitor the MAC address. Generally, DHCP is the default settings,
but if you don’t have a DHCP server, you must configure the network settings by using manual

configuration.

PAC Utility [1.2.0.6] M [=]

LAN 1:

MaC Address: 78-C5-E5-83-06-8C
@ Use DHCP to get IP address
() assign IP address

IP Address: |1|:|,1,|:|.E;E.

Gatewsay:  |10.1.0.254

|
Mask: [255.255.0.0 |
|
|

DMS Server: |1D.D.D.3

["] Reboot for changes to take effective

The tab use to l How to use

Use DHCP to get IP address:
Select the Use DHCP to get IP address option, and then click the Apply
button.

Set the network

settings .
Assign an IP address:
Select the Assign IP address option, and then click the Apply button.
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3.1.7. Property Tab — Network

The Network tab comprises three tabs — Access, Login and File Server Settings.

Access

The Access tab provides functions to enable/disable the FTP access, enable/disable anonymous
FTP access, and configure the FTP and HTTP directory path.

PAC Utility [1.2.1.4] ! E

[General General2 IDispIay IIF' Config | MNetwark | Device Information Iﬁuh:u Execution IRDtary Exe 4| »

ACCESS | Login IFiIe Server Seffings I

FTF (W) Enable () Disable

Allow Anonymous @ Enable () Disable

Set FTP default download directory to:

' ||| et

Set HTTF document root directory to:

R aTe w =L aTH || || Apply

The tab use to How to use

Enable the FTP access:

Select the Enable check box in the FTP field, and then click the
Enable or disable the Apply button.

FTP access Disable the FTP access:
Select the Disable check box in the FTP field, and then click the
Apply button.
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The tab use to How to use

Enable anonymous FTP access:
) Select the Enable check box in the Allow Anonymous field, and then
Enable or disable )
click the Apply button.
anonymous FTP .
Disable anonymous FTP access:
access
Select the Disable check box in the Allow Anonymous field, and then
click the Apply button.
Set the FTP Enter a new path in the Set FTP default download directory to: field,
directory path and then click the Apply button.
Set the HTTP Enter a new path in the Set HTTP document root directory to: field,
directory path and then click the Apply button.
Login

The Login tab provides functions to maintain the FTP accounts.

PAC Utility [1.2.1.4] ! E

[General I General2 I Display IIF' Config | Metwork | Device Information Iﬁuh:u Esxtecution IRDtary Exg 1] »

[Access | Login | File Server Settings |

User MNarme Password

Jdmin | [+ || add || Delete

Lser name Passwiord

The tab use to How to use
Maintain the FTP Refer to the Appendix C.1 How to add a user account to remote
accounts login the VP-1231-CE7 from PC.
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File Server Settings

The File Server Settings tab provides functions to set the SMB server.

PAC Utility [1.2.0.6] M [=]

[General IDisplay IIF' Caonfig | Metwork | Device Information I Auto Execution I Rotary Execution |

ACCess I Login | File Server Settings |

You can create a networked file server and enables clients to store and
retrieve files, and makes use of the Internet for communication betwesn
client devices and other shared equipment.

|| Settings Share Files System Settings !

Device Mame {Each device need setting
a different device name)

|C|:| rpact |

The path 1o the folder to be shared

Configure the file server to use LANY as
the network adapter

|PcrFETCESRZ ~]

Enable all authentication on the file
server, The file server will not be
accessible to all users on the

D network and the "admin" as the
Lser to be allowed access o the
file server

Set

Heln

The tab use to How to use
Set the SMB server Click the Settings button to set the SMB server path.
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3.1.8. Property Tab — Device Information

The Device Information tab provides functions to monitor necessary system information of the
VP-1231-CE7. The information is the most important note of version control for upgrading system.

PAC Utility [1.2.1.4] ! E m
| General | General2 | Display | 1P Confi | Network || Device Information | uto Execution | Rotary Exe_¢| » |
sot1: [ | Modue(cPu)Type: | |
St2: [ ]  serial Number: |01-82-4D-06-18-00-00-DA |
Slot 3: |:] Backplane Version: | I

CPU Version: [1000 |
OS Version: [1.0.1.1, 2015/10/30 09:36:5 |
Eboot Version: [1.2.1.0, 2015/10/22 16:26:0 |
NET CF version:  [3.5.7338.00 |
SQLCEVersion:  [35.8154.0 |
PACSDK Version:  [4.3.3.4 |
CPU Temperatre: | |
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3.1.9. Property Tab — Auto Execution

The Auto Execution tab provides functions to configure programs running at VP-1231-CE7 startup,

it allows users to configure ten execute files at most.

Tips & Warnings

Q The specific extensions are .exe and .bat, and they are executed in order of
program 1, program 2, etc.

PAC Utility [1.2.1.4] ! E

[ General I General2 I Display I IF Config I Metwork IDeuice Information | ALto Execution | Rotary Exg 1| ¥

Program 1: |"-.-"_REMDTE.E}{E | Browse |

Prograrm 2 | | | Browse I
Prograrm 3: | | | Browse I
Prograrm 4: | | | Browse I
At most 10 programs  Fregram S: | | | Brawse |
can be specified to .
ExeCUtE autormatically Frogram &: | | | Browse |
at system startup. Program 7: | | " Browse |
Program 2: | | | Browse |
Prograrm 9: | | | Browse |
Programl0; | | | Browse I

The tab use to l How to use
Configure programs Click the Browse button to select the execute file which you want,
running at startup and then click the Apply button.
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3.1.10. Property Tab — Rotary Execution

The Rotary Execution tab provides functions to configure programs running at VP-1231-CE7
startup in one of the user defined mode, it allows users to configure ten execute files at most.

PAC Utility [1.2.1.4] ! E

[GeneraIE IDispIay IIF' Config INetwurk IDevice Information IAu’o:u Execution | Rotary Execution m 4>

Rotary Switch 9:

Rotary Switth 0 [normal Mode | Browse |
Rotary Switch 11 |safe Mode || Erowse |
Rotary Switch 2: | | | Browse |
Rotary Gwitch 3: | || Browse |
Rotary Switch 4: | | Browse_|
Rotary Switch 5: | || Browse |
Rotary Switch 6: | | Browse_|
Rotary Switch 7: | | _Browse |
Rotary Switch 8: | | _Browse |
|

| Browse |

The tab use to How to use

Configure programs running at startup | Click the Browse button to select the execute file

in one of the user defined mode which you want, and then click the Apply button.
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3.2. DCON Utility Pro

DCON Utility Pro enables users easily to configure and manage the I/O modules via Ethernet or
serial ports (RS-232/RS-485).

For more information on how to use DCON Utility Pro to configure I/O modules, please refer to 2.5.
Using DCON Utility Pro to Configure I/O Modules

For more detailed information on DCON Utility application, please refer to:

http://www.icpdas.com/root/product/solutions/software/utilities/dcon utiltiy pro.html

DCON Utility Pro CE V 2.0.0.4

Start Address 0 End Address |4
o Addr... | Baud Rate | Checks... |Format| Status | Description

Terminal Command Line Tool
COMPart  |COMO[Backplane =] Protocol — [SCO] =
Baud Rate |1152OO E| Format |N,8, 1-Mone Parity El Send
Checksum  [Disable = gt [slotol=] | ]
Timeout  [100 ms SelectiD | =
Cormmand 300M
Response
I
4 I 'E ata Logger I Aboutl
[ COM Port COM Port |COMD El Load
ICOMD E Protocal IDCON :I
Baud Rate [115200 ~] Remove

Data Format |N,8J1 El Add ==

Checksurm IDisabIe :I

Slat | ~] Modify rty |

Timeout (ms) Iggg(ms) E' Cave

Delay for Next (ms) |2E|E|(ms) :I

Command Reference | E'

Send Command |$DlM |

Compared Response |Input Compared Data |

Compare Made |Fu|| Match El
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3.3. TaskMgr

The TaskMgr is a Windows CE application, which provides real time info on all processes and

threads including System threads, similar in appearance to the Windows Task Manager.

Windows CE Task Manager

Performance IPmcesses Iﬁpp]j;:aticu 1 n
100

Windows CE Task Manager

Lpplicatio n u

Procesaes

Irmage Marm... | Threa... | Llern. izl

Tasmfrﬁger'” Windows CE Task Manager

w_remote exe

servicesd exe Applisations | Disk | et 4] P

explorer.exe |

Usage 2% Garellser.exe Task

ndenice exe
| udevieee VY Virtual CE

NE BEYE

1

- |
a | B
Cloze Switch
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3.4. VCEP

ICP DAS VCEP is designed for managing your VP-1231-CE7 anywhere. No matter where you are, ICP
DAS VCEP provides a convenient environment on the Desktop PC and lets you control your
VP-1231-CE7 remotely.

virtual CE ]
File Help E

Vindual CE 5

Connected
Ready
Primary IF = 10.1.0.94

License Free ersion

Wideo=G01

wwey fCpidas, com

ICP DAS VCEP is composed of two main components: The Server which runs on VP-1231-CE7 and
the Client which runs on a Desktop PC.

Once a connection is established between the client and server (initiated by the client), the client
will periodically send requests for screen updates and send mouse/key click information to the

server to simulate.

Each video frame is inter-compressed against the previous frame and then intra-compressed with a

modified LZW scheme to minimize the amount of data transmitted from server to client.

For more detailed information on VCEP application, please refer to
http://ftp.icpdas.com.tw/pub/cd/winpac_am335x/VP-1231-CE7/pc tools/vcep/
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3.5. Remote_Display

The Remote Display allows VP-1231-CE7 to be controlled and monitored from a remote location.

This tool is composed of two parts, a client and a server. The server is a program named
cerdisp.exe running on VP-1231-CE7. The client is a PC-based program named cerhost.exe running
on the PC.

cerdisp cerhost

Once a connection is established between the client and server (initiated by the client), the client
will periodically send requests for screen updates and send mouse/key click information to the

server to simulate.
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3.6. SendToCOM

The SendToCOM uses the serial port to communicate with expansion module. To use the
SendToCOM, you can send data to expansion module through the serial port, and receive data
from other device through the serial port.

For more information about these commands for communicating with expansion module, please
refer to:

http://www.icpdas.com/root/product/solutions/remote io/rs-485/i-8k i-87k/i-8k i-87k selection.
html#b

ICPDAS Send to COM V1.0.4 2011f2/23
Caonneckion Skatus
COM Part Baudrate [rata Bit Parity: Stop Bit Slak
o =] [rsew [] b [=] fpereroy =] |© 1= |
Endstring with @ mone (YJLFcR (YR (O crIF (OLWF [string | B4 +cre
Binar Skrin m Palling
Comrmands Responses O 4 @ d - -
Current Packet Size (bytes) g Current Packet Size (bybas) g futa send Internal (ms)  |sop
Total Packet Bytes 1] Total Packet Bytes 1] | Skart | | Stop | Set
Packet Quantity send i Packet Quantity received |0 chart Time |Start Tme
ﬂl Stop Time  |Stop Time
FS Fs
w o
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3.7. RegEdit

The RegEdit provides a hierarchical representation of the registry on a target computer, similar in
appearance to the Windows Registry Editor. The standard registry roots are represented; you can
add keys beneath a root to point to existing registry keys, or you can add your own keys. Values can
be changed for existing keys, or added for new keys, and default keys can be specified. For more

information, see Registry Settings Management in Deployment.

Registry Editor Version 1.2.2 ! E

File Help
; L T
B HKEY_CURREMT _USER
B HKEY_LOCAL_MACHINE
L HKEY_USERS

Name | Type | pata |
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3.8. 1SQLW35

The ISQLW35 is a Windows Embedded Compact 7 functionality that implements SQL Server
Compact 3.5 Query.

’é; Cbjects soL | [ arid Motes
..... ) T

Tools 501 | [ 1 U X
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3.9. INotepad

The INotepad is a common text-only editor. The resulting files have no format tags or styles.

INotepad !
File Edit Format Help

e

Escl1[2[3]4[5]6|[7][8[9]0]- =4«
Tab[q[wle[r[t]y[uli]o]p|[]]
CAPa|s|d[f|g|h[j|k]|I];
Shift|z|[2[c|v|[b|[nm|.].]}
J culai]* T\ ] [e]r]e]>
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4. Your First VP-1231-CE7 Program

This chapter provides a guided tour that describes the steps needed to set-up a development

environment, download, install, configure for user programming with VP-1231-CE7 modules.

4.1. Setting up the Development Environment

Before writing your first program, ensure that you have the necessary development tool and the
corresponding SDKs are installed on your system.
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4.1.1. Preparing the Development Tools and Programming Languages

VP-1231-CE7 is a Windows CE-based device that supports three programming languages for
developing Windows CE applications.

e Visual Basic.NET
e Visual CH

® Visual C++

Development Tools

VP-1231-CE7 supports the application development with the Professional Edition application of
Visual Studio 2008.

\ Micrpsoft‘ .
P Visual Studio 2008

Professional Edition

Tips & Warnings

A There are some updates for Visual Studio 2008 to provide support for
Windows Embedded Compact 7.

If you have Professional Edition of Visual Studio 2008 are installed, make

sure all of the following package are installed

1. Visual Studio 2008 Service Pack 1

http://www.microsoft.com/en-us/download/details.aspx?id=10986

2. Visual Studio 2008 update for Windows Embedded Compact 7

http://www.microsoft.com/en-us/download/confirmation.aspx?id=11935

3. Windows Embedded Compact 7 ATL Update for Visual Studio 2008 SP1

http://support.microsoft.com/kb/2468183/en-us
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4.1.2. Installing the VP-1231-CE7 SDK

The VP-1231-CE7 SDK offers several APIs for customizing the standard features and integrating
with other applications, devices and services.

Step 1: Get the latest version of the VP-1231-CE7 SDK, AM335x_WINCE7_SDKV100B03

The VP-1231-CE7 SDK can be found from the CD that was provided with the package

or by downloading the latest version from ICP DAS web site.

CD:\VP-x231\SDK\PlatformSDK\
http://ftp.icpdas.com/pub/cd/winpac am335x/vp-x231/sdk/platformsdk/

Step 2: Execute the AM335x_WINCE7_SDK_YYYYMMDD.msi

Follow the prompts until the installation process is complete.

Step 3: Execute the VisualStudioDeviceWindowsEmbeddedCompact?7

Follow the prompts until the installation process is complete.
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4.2. First VP-1231-CE7 Program in VB.NET

The best way to learn programming with VP-1231-CE7 is to actually create a VP-1231-CE7 program.

The example below demonstrates how to create a demo program running on VP-1231-CE7 with
VB.NET.

To create a demo program with VB.NET that includes the following main steps:

1. Create a new project

2. Specify the path of the PAC reference

3. Add the control to the form

4. Add the event handling for the control
5. Upload the application to VP-1231-CE7
6. Execute the application on VP-1231-CE7

All main steps will be described in the following subsection.

In this tutorial, we will assume that you have installed VP-1231-CE7 SDK on PC and used the Visual
Studio 2008 for application development.
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4.2.1. Create a new project

The Visual VB.net project template is a composite control that you use in this example creates a

new project with this user control.

Step 1: Start Visual Studio 2008

"2

Step 2: On the File menu, point to New, and then click Project

File | Edit View Tools Test Window Help

New » o] Project. Ctrl+Shift+N
| Open » | @  WebSite.. Shift+Alt+N
Close ‘1 | File.. Ctrl+N

7] | Close Solution Project From Existing Code...

7 | Save Selected Items  Ctrl+5S
Save Selected Items As...

@ SaveAll Ctrl+Shift+S
Export Template..

Lt | Page Setup...

4 | Print.. Ctrl+P
Recent Files 3
Recent Projects »
Exit
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Step 3: In the Project types pane, expand Visual Basic node and select Smart Device

Step 4: In the list of Templates, select Smart Device Project

Step 5: Specify a name and a location for the application and then click OK

Project types: Templates: I-NET Framework 3.5 ~ ]

General + || Visual Studio installed templates

MFC | el Smart Device Project|

Smart Device

Test

Win32

Other Languages

Visual Basic
Windows
Web
Smart Device
Office
Database
Reporting
Test L
WCF
Workflow

Visual C#

A project for Smart Device applications. Choose target platform, Framework version, and template in the next dialog box.

— || My Templates

.} Search Online Templates...

m

-

Name: SDK_Info
Location: C\Users\Administrator\Documents\Visual Studio 2008\Projects - Browse...
Solution Name: SDK_Info Create directory for solution
OK | l Cancel l
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Step 6: In the Target platform, select Windows CE

Step 7: In the .NET Compact Framework version, select .NET Compact Framework
Version 3.5.

Tips & Warnings

Windows CE7 only supports .NET Compact Framework Version 3.5, if your
application uses .NET Compact Framework Version 2.0 there is no guarantee

that the program will function correctly.

Step 8: In the list of templates, select Device Application. Click OK

Add New Smart Device Project - SDK Info ‘ ‘ @g
.

Target platform: ’Windc:-ws CE vl

NET Compact Framework version: ’.NET Compact Framewaork Version 2.5 vl

Templates:

: _ =
@ W ¥ @ .
=, = = = Description:
Device Class Console Control Empty . ]

Application  Library  Application  Library Project A project for creating a .NET
Compact Framework 3.5 forms
application for Windows CE
Platform

Download additonal emulator images and smart device SDKs...

1

OK J [ Cancel l
W #
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4.2.2. Specify the path of the PAC reference

The PAC SDK provides a complete solution to integrate with VP-1231-CE7 and it’s compatible with
Visual C#, Visual Basic.NET and C++. In order to use a component in your application, you must first
add a reference to it.

Stepl: Get the PACNET.dII

e

ﬂﬂé

PACNET.II

The PACNET.dIl can be found from the CD that was provided with the package or by
downloading the latest version from ICP DAS web site.

CD:\VP-x231\SDK\PACNET\
http://ftp.icpdas.com/pub/cd/winpac am335x/vp-x231/sdk/pacnet/

Step 2: On the Project menu, and then click Add Reference...

ﬁg SDEK Info - MicrosofTVisual_Studio (Administrator)_n i
File Edit Viewm Build Debug Data Format Tools Test Window Help

Add Windows Form...

Add User Control...

Add Component...

Add Module...

Add Class..

Add New Item... Ctrl+Shift+A
Add Existing Item...  Shift+Alt+A

El B & BB B [

Exclude From Project
Show All Files

Add Reference...

Add Web Reference...
Set as StartUp Project

EE,

+4 | Refresh Project Toolbox Items

Change Target Platform...
SDK_Info Properties... Alt+F7
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Step 3: On the Browse tab and browse to where the PACNET.dIl are installed, and then
click OK

Add Reference ‘ ‘ @u
|.NET | Projects| Browse |Recent
Lookin: | PACNET - @@~
Mame ) Date modified
| @ PACNETdII 2014/5/30
<« | I b
Filename: : PACNET -
Files of type: : [Component Files {* dll:* tlb:* olb:* ocu ¥ exe) v]
QK ‘ ‘ Cancel
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4.2.3. Add the control to the form

You can drag various controls from the Toolbox onto the form. These controls are not really "live";

they are just images that are convenient to move around on the form into a precise location.
After you add a control to your form, you can use the Properties window to set its properties, such

as background color and default text. The values that you specify in the Properties window are the
initial values that will be assigned to that property when the control is created at run time.

Step 1: On the Toolbox panel, drag a Button control onto the form

Toolbox + 11 X
All Device Controls &)
B Common Device Contr...

k Pointer
| Button

CheckBox
ComboBox

T DateTimePicker
A Label o D
A LinkLabel 1 Buttonl |
ListBox

:: ListView

F] MonthCalendar
NumericUpDown
[ PictureBox

@ ProgressBar

® RadioButton

+|+ Splitter

TextBox

% TrackBar

i TreeView

= WebBrowser
Device Containers o
Device Menus & Toolb...
Device Data

Device Components
Device Dialogs

B General -

a5 | T. B AR]

m
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Step 2:

On the Properties panel, type Check the SDK version in the Text field

Properties

Buttonl System.Windows.Forms.Button

o=]4) [B]# |E

E Appearance
BackColor [ ] Control
Font Tahoma, 10pt

ForeColor . ControlText

Check the SDK Version|
= Behavior

ContextMenu (none)

DialogResult None

a Check the SDK Version |
LF )

The text contained in the control.

Enabled True

TabIndex 0

TabStop True -
Text
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4.2.4. Add the event handling for the control

You have finished the design stage of your application and are at the point when you can start

adding some code to provide the program's functionality.

Step 1: Double-click the button on the form

a Check the SDK Version
LF

Step 2: Inserting the following code

Dim data(30) As Byte
PACNET.Sys.GetSDKVersion(data)

MessageBox.Show(PACNET.MISC.WideString(data))

EPohlic Class Forml ;3
{

Private Sub Buttonl Click(BvVal sender As Svstem.0bject, ByVal e @EL
3

Din data(30) As Byte ~

PACHET .5vs.GetsDEVersionidata) {}

| MessageBox . Show(PACKET . MISC . WideString{data)) f}

End Suh
End Class E}

\/wmwwvmumw ""“v"‘"‘\f

Tips & Warnings

A The “PACNET” of “using PACNET” is case- sensitive.
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4.2.5. Upload the application to VP-1231-CE7

VP-1231-CE7 supports FTP server service. You can upload files to VP-1231-CE7 or download files
from a public FTP server.

Step 1: On the Build menu, and then click Build [Project Name]

File Edit View Project |Build | Debug Data Format Tools Test Window Help
Build Solution F7
Rebuild Solution  Ctrl+Alt+F7

Deploy Solution
Clean Solution
## Build SDK _Info
Rebuild SDK_Info
Deploy SDK_Info
Clean SDK_Info

Configuration Manager...
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Step 2: Open the browser and type the IP address of VP-1231-CE7

Step 3: Upload the application and the corresponding PACNET.dII files to VP-1231-CE7

Tips & Warnings

A For applications programming in C# and VB.net with .net compact
framework, when executing these application on VP-1231-CE7, the

corresponding PACNET.dIl must be in the same directory as the .exe file.

| File Edit View Go Favorites ||”J|£
”]Agldress | YTemp

= O

PACMET SDK_Info

R/\U/v‘“"\

N N YA
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4.2.6. Execute the application on VP-1231-CE7

After uploading the application to VP-1231-CE7, you can just double-click it on VP-1231-CE7 to

execute it.

SDK_Info | Check the SDK VYersion | W
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4.3. First VP-1231-CE7 Program in Visual C#

The best way to learn programming with VP-1231-CE7 is to actually create a VP-1231-CE7 program.

The example below demonstrates how to create a demo program running on VP-1231-CE7 with
Visual C#.

To create a demo program with Visual C# that includes the following main steps:

1. Create a new project

2. Specify the path of the PAC reference

3. Add the control to the form

4. Add the event handling for the control
5. Upload the application to VP-1231-CE7
6. Execute the application on VP-1231-CE7

All main steps will be described in the following subsection.

In this tutorial, we will assume that you have installed VP-1231-CE7 SDK on PC and used the Visual
Studio 2008 for application development.
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4.3.1. Create a new project

The Visual C# project template is a composite control that you use in this example creates a new

project with this user control.

Step 1: Start Visual Studio 2008

"2

Step 2: On the File menu, point to New, and then click Project

File | Edit View Tools Test Window Help

New » o] Project. Ctrl+Shift+N
| Open » | @  WebSite.. Shift+Alt+N
Close ‘1 | File.. Ctrl+N

7] | Close Solution Project From Existing Code...

7 | Save Selected Items  Ctrl+5S
Save Selected Items As...

@ SaveAll Ctrl+Shift+S
Export Template..

Lt | Page Setup...

4 | Print.. Ctrl+P
Recent Files 3
Recent Projects »
Exit
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Step 3: In the Project types pane, expand Visual C# node and select Smart Device

Step 4: In the list of Templates, select Smart Device Project

Step 5: Specify a name and a location for the application and then click OK

Project types: Templates: I-NET Framework 3.5 ~ ]

Visual C++ Visual Studio installed templates
Other Languages S Smart Device Project
Visual Basic
Visual C#
Windows
Web
Smart Device
MySQL
Office
Database
Reporting
Test
WCF
Workflow
Other Project Types
Test Projects

My Templates

;i Search Online Templates...

A project for Smart Device applications. Choose target platform, Framework version, and template in the next dialog box.

Name: SDK_Infq|
Location: CA\Users\Administrator\Documents\Visual Studio 2008\Projects - Browse...
|| Solution: [Create new Solution '] Create directory for solution
Solution Name: SDK_Info
OK | l Cancel
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Step 6: In the Target platform, select Windows CE

Step 7: In the .NET Compact Framework version, select .NET Compact Framework
Version 3.5.

Tips & Warnings

Windows CE7 only supports .NET Compact Framework Version 3.5, if your
application uses .NET Compact Framework Version 2.0 there is no guarantee
that the program will function correctly.

Step 8: In the list of templates, select Device Application. Click OK

———
Add -

Target platform: lWindgws CE v] I

NET Compact Framework version: I.NET Compact Framework Version 3.5 ']

Templates:

: =
] Description:
Device Class Consale Control Empty ] .

Application  Library  Application  Library Project A project for creating a NET
Compact Framework 3.5 forms
application for Windows CE
Platform

| Download additonal emulator images and smart device SDK...
OK ] l Cancel
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4.3.2. Specify the path of the PAC reference

The PAC SDK provides a complete solution to integrate with VP-1231-CE7 and it’s compatible with
Visual C#, Visual Basic.NET and C++. In order to use a component in your application, you must first
add a reference to it.

Stepl: Get the PACNET.dII

e

ﬂﬂé

PACNET.II

The PACNET.dIl can be found from the CD that was provided with the package or by
downloading the latest version from ICP DAS web site.

CD:\VP-x231\SDK\PACNET\
http://ftp.icpdas.com/pub/cd/winpac am335x/vp-x231/sdk/pacnet/

Step 2: On the Project menu, and then click Add Reference...

ﬁg SDEK Info - MicrosofTVisual_Studio (Administrator)_n i
File Edit Viewm Build Debug Data Format Tools Test Window Help

Add Windows Form...

Add User Control...

Add Component...

Add Module...

Add Class..

Add New Item... Ctrl+Shift+A
Add Existing Item...  Shift+Alt+A

El B & BB B [

Exclude From Project
Show All Files

Add Reference...

Add Web Reference...
Set as StartUp Project

EE,

+4 | Refresh Project Toolbox Items

Change Target Platform...
SDK_Info Properties... Alt+F7
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Step 3: On the Browse tab and browse to where the PACNET.dIl are installed, and then
click OK

Add Reference ‘ ‘ @u
|.NET | Projects| Browse |Recent
Lookin: | PACNET - @@~
Name ) Date modified
| a| PACNET.dII 2014/5/30
<« | I b
Filename: : PACNET -
Files of type: : [Component Files {* dll:* tlb:* olb:* ocu ¥ exe) v]
OK ‘ ‘ Cancel
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4.3.3. Add the control to the form

You can drag various controls from the Toolbox onto the form. These controls are not really "live";

they are just images that are convenient to move around on the form into a precise location.
After you add a control to your form, you can use the Properties window to set its properties, such

as background color and default text. The values that you specify in the Properties window are the
initial values that will be assigned to that property when the control is created at run time.

Step 1: On the Toolbox panel, drag a Button control onto the form

Toolbox + 11 X
All Device Controls &)
B Common Device Contr...

k Pointer
| Button

CheckBox
ComboBox

T DateTimePicker
A Label

A LinkLabel
ListBox

:: ListView

F] MonthCalendar
NumericUpDown
[ PictureBox

@ ProgressBar

® RadioButton

+|+ Splitter

TextBox

% TrackBar

i TreeView

= WebBrowser
Device Containers o
Device Menus & Toolb...
Device Data

Device Components
Device Dialogs

B General -

a5 | T. B AR]

m
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Step 2:

On the Properties panel, type Check the SDK version in the Text field

Properties

Buttonl System.Windows.Forms.Button

o=]4) [B]# |E

E Appearance
BackColor [ ] Control
Font Tahoma, 10pt

ForeColor . ControlText

Check the SDK Version|
= Behavior

ContextMenu (none)

DialogResult None

a Check the SDK Version |
LF )

The text contained in the control.

Enabled True

TabIndex 0

TabStop True -
Text
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4.3.4. Add the event handling for the control

You have finished the design stage of your application and are at the point when you can start
adding some code to provide the program's functionality.

Step 1: Double-click the button on the form

% Check the SDK Version E

Step 2: Inserting the following code

byte[] data = new byte[30];
PACNET.Sys.GetSDKVersion(data);

MessageBox.Show(PACNET.MISC.WideString(data));

"“"’“_\m/l\-""";-'\fm\*ﬁ‘a\ N e e A VN A Sy

= private void buttonl Click{object sender, Eventhros el
{

bvte[] data = new hyvte[30];

PACHET .5vs .GetSDEYersionidata);

MessapeBox .Show(PACHET MISC WideString{data));

- ﬂwdﬁ

Tips & Warnings

A The “PACNET” of “using PACNET” is case- sensitive.
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4.3.5. Upload the application to VP-1231-CE7

VP-1231-CE7 supports FTP server service. You can upload files to VP-1231-CE7 or download files
from a public FTP server.

Step 1: On the Build menu, and then click Build [Project Name]

File Edit View Project |Build | Debug Data Format Tools Test Window Help
Build Solution F7
Rebuild Solution  Ctrl+Alt+F7

Deploy Solution
Clean Solution
## Build SDK _Info
Rebuild SDK_Info
Deploy SDK_Info
Clean SDK_Info

Configuration Manager...
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Step 2: Open the browser and type the IP address of VP-1231-CE7

Step 3: Upload the application and the corresponding PACNET.dII files to VP-1231-CE7

Tips & Warnings

A For applications programming in C# and VB.net with .net compact
framework, when executing these application on VP-1231-CE7, the

corresponding PACNET.dIl must be in the same directory as the .exe file.

| File Edit View Go Favorites ||”J|£
”]Agldress | YTemp

= O

PACMET SDK_Info

R/\U/v‘“"\

N N YA
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4.3.6. Execute the application on VP-1231-CE7

After uploading the application to VP-1231-CE7, you can just double-click it on VP-1231-CE7 to

execute it.

SDK_Info | Check the SDK VYersion | W
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4.4. First VP-1231-CE7 Program in Visual C++

The best way to learn programming with VP-1231-CE7 is to actually create a VP-1231-CE7 program.

The example below demonstrates how to create a demo program running on VP-1231-CE7 with
Visual C++.

To create a demo program with Visual C# that includes the following main steps:

1. Create a new project

2. Configure the Platform

3. Specify the path of the PAC reference

4. Add the control to the form

5. Add the event handling for the control
6. Upload the application to VP-1231-CE7
7. Execute the application on VP-1231-CE7

All main steps will be described in the following subsection.

In this tutorial, we will assume that you have installed VP-1231-CE7 SDK on PC and used the Visual
Studio 2008 for application development.
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4.4.1. Create a new project

The Visual C# project template is a composite control that you use in this example creates a new

project with this user control.

Step 1: Start Visual Studio 2008

"2

Step 2: On the File menu, point to New, and then click Project

File | Edit View Tools Test Window Help

New » o] Project. Ctrl+Shift+N
| Open » | @  WebSite.. Shift+Alt+N
Close ‘1 | File.. Ctrl+N

7] | Close Solution Project From Existing Code...

7 | Save Selected Items  Ctrl+5S
Save Selected Items As...

@ SaveAll Ctrl+Shift+S
Export Template..

Lt | Page Setup...

4 | Print.. Ctrl+P
Recent Files 3
Recent Projects »
Exit
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Step 3: In the Project types pane, expand Visual C++ node and select Smart Device

Step 4: In the list of Templates, select MFC Smart Device Application

Step 5: Specify a name and a location for the application and then click OK

-

Project types: Templates: NET Framework 3.5 ¥ ]
Visual C++ Visual Studio installed templates
ATL EATL Smart Device Project <@ MFC Smart Device ActiveX Control
CLR ,ﬁﬁMFC Smart Device Application s MFC Smart Device DLL
ae;r;:eral sElWin32 Smart Device Project
Smart Device My Templates
Test [ Search Online Templates...
Win32
Other Languages
Other Project Types

Test Projects

An application for Windows Mobile and other Windows CE-based devices that uses the Microsoft Foundation Class Library

Name: SDK Infq|
Location: CA\Users\Administrator\Documents\Visual Studio 2008\Projects -
Solution Name: SDK_Info Create directory for solution
QK ] l Cancel l
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Step 6: On the first page of the wizard, click Next

% Welcome to the MFC Smart Device Application Wizard
F

These are the current project settings:
® Windows Mobile 5.0 Pocket PC SDK Platform
® Single document interface

Overview

Platforms

Application Type
Document Template Strings Click Finish from any window to accept the current settings.

After you create the project, see the project's readme.t file for information about the project features
and files that are generated.

User Interface Features
Advanced Features

Generated Classes

< Previous | Mext > |[ Finish H Cancel

Step 7: On the next page of the wizard, select AM335x_WINCE7_SDK to be added to the
project, and then click Next

——== Platforms

Overview Select platform SDKs to be added to the current project.

Platforms

Application Type
Document Template Strings

Installed SDKs: Selected SDKs:

User Interface Features |Pocket PC 2003 AM335x WINCE7_SDK

Smartphone 2003
Windows Mobile 5.0 Pocket PC SDK
Windows Mobile 5.0 Smartphone S

Advanced Features

Generated Classes

BB

AM335x_WINCE7_SDK
’7MStruction sets: ARMv4I, ARMv4I

[<Previous” Next > H Finish H Cancel
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Step 8: On the next page of the wizard, select Dialog based, and then click next

Application Type

Overview Application type: Use of MFC:
Platforms © single document () Use MFC in a shared DLL
Application Type @ Dialog based @ Use MFC in a static library

Document Template Strings O Single document with DocList

User Interface Features
+| Document/View architecture support
Advanced Features

Resource language:

|=x (=)

Generated Classes

<Previons” Next = ” Finish ” Cancel

Step 9: On the next page of the wizard, click next

' ™
User Interface Features

Overview Command bar:

Platforms ¢ Menus only

Application Type Menus and buttons

Document Template Strings

User Interface Features Status bar

Advanced Features Dialog title:

Generated Classes SDK_Info

[<Previous|[ mext> |[ Finish |[ cancel
\ - - J
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Step 10: On the next page of the wizard, click next

Advanced Features

Overview Advanced features:
Platforms [ windows Help
Application Type | Printing and print preview

Document Template Strings 4

User Interface Features B windows sockets

Advanced Features
Number of files on recent file list:

G ted Cl
enerated Classes

<Previous” Next > H Finish ” Cancel

Step 11: On the next page of the wizard, click Finish

' ™
— Generated Classes
Overview Generated classes:
Platforms
CSDK_InfoDlg
Application Type
Document Template Strings
User Interface Features -
Class name: h file:
Advanced Features CSDK_InfoApp |5DK_Inf-:-.h |
Generated Classes
Base class: cpp file:
CWinApp |SDK_Inf-:-.cp|J |
[<Previous| 1ed- |[ Finish || cancel
i L 3 v
VP-1231-CE7 User Manual, v1.0.0 Page: 89

Copyright © 2016 ICP DAS Co., Ltd. All Rights Reserved. E-mail: service@icpdas.com




4.4.2. Configure the Platform

When developing applications by using Visual C++, you must configure the Platform to indicate
what platform and device you intend to download the application to. Before you deploy your
project, check the platform.

On the Debug configuration toolbar, select Release and select AM335x_WINCE7_SDK(ARMv4l) as

shown in the following illustration.

AR RA A" B- IR REE Y R AT r.Jv_ﬂ b Release vAM335x_MNCE?_sv\[§

N

L/
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4.4.3. Specify the Path of PACSDK library and header files

The PAC SDK provides the PACSDK library and header files with VP-1231-CE7.
It’s compatible with C++. In order to use a component in your application, you must first add a
reference to it.

Step 1: On the View menu, and then click Property Pages

File Edit | View | Project Build Debug Tools Test Window Help

=3 | Solution Explorer Ctrl+Alt+L
) | Bookmark Window Ctrl+K, Ctrl+W
5% | Class View Ctrl+Shift+C
[ & Code Definition Window  Ctrl+Shift+V
=%  Object Browser Ctrl+Alt+)
=] | Output Alt+2
':all Property Manager
| | Resource View Ctrl+Shift+E
3 | Toolbox Ctrl+Alt+X
Find Results »
Other Windows b
Toolbars »
= | Full Screen Shift+Alt+Enter
w1 | Navigate Backward Ctrl+-
5, | Navigate Forward Ctrl+Shift+-
Next Task
Previous Task
Property Pages
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Step 2: In left pane, expand Configuration Properties, and then click C/C++

Step 3: In the right pane, choose the following path in the Additional Include
Dependencies item

C:\Program Files\Windows CE Tools\SDKs\N2000_WINCE7_SDK\Include\Armv4i

C:\Program Files\Microsoft Visual Studio 9.0\VC\atimfc\include

SDK_Info Property Pages » M

Configuration: |Active(Release) VI Platform: lActive(AM335)(_WINCE?_SDK(. v] l Configuration Manager... ]

Common Properties Additional Include Directories "C:\Program Files (x86)\Windows CE Tools\SDKs\AM B

Configuration Properti Resolve #using References

General Debug Information Format Program Database (/Zi)

Debugging Suppress Startup Banner Yes (/nologo)

Deployment Warning Level Level 3 (/W3)

C/C++ Detect 64-bit Portability Issues No
Gen.ere-zl _ Treat Warnings As Errors No
Optimization
Preprocessor
Code Generation
Language
Precompiled Hea
Output Files
Browse Informati
Advanced
Command Line

Linker

Resources

XML Document Gen

Browse Information P

Build Events

Custom Build Step

Authenticode Signir

Additional Include Directories
Specifies one or more directories to add to the include path; use semi-colon delimited list if more..

0K || Cancel Apply
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Step 4: In left pane, click Linker

Step 5: In the right pane, choose the following path in the Additional Library
Dependencies item

C:\Program Files\Windows CE Tools\SDKs\N2000_WINCE7_SDK\Include\Armv4i

SDK _Info Property Pages - M

Configuration: lActive(Release) ¥ | Platform: |Active(AM335x WINCE7 SDK (; ~ l l Configuration Manager... l
Common Properties Qutput File $(0utDir\$(ProjectName).exe
Configuration Properti Show Progress Not Set
General Wersion
Debugging Enable Incremental Linking No (/INCREMENTAL:NO)
Deployment Suppress Startup Banner Yes (/NOLOGQO)
C/C++ Ignore Import Library No
Linker Register Output No
General Per-user Redirection No
Input "C:\Program Files (x86)\Windows CE Tools\SDKs\AM{...]
Manlfest. File Link Library Dependencies Yes
E;;:?ngmg Use Library Dependency Inputs No
e Use UNICODE Response Files Yes
Optimization
Embedded IDL
Advanced

Command Line
Resources
XML Document Gen
Browse Information
Build Bvents by
Custom Build Step
Authenticode Signir

Additional Library Directories
Specifies one or more additional paths to search for libraries; configuration specific; use semi-col...

[ ok ][ concel Apply
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4.4.4. Add the control to the form

You can drag various controls from the Toolbox onto the form. These controls are not really "live";

they are just images that are convenient to move around on the form into a precise location.
After you add a control to your form, you can use the Properties window to set its properties, such

as background color and default text. The values that you specify in the Properties window are the
initial values that will be assigned to that property when the control is created at run time.

Step 1: On the View menu, and then click Resource View

File Edit | View | Project Build Debug Tools Test Window Help

[z] | Code Ctrl+Alt+0
L‘-‘j Solution Explorer Ctrl+Alt+L
) | Bookmark Window Ctrl+K, Ctrl+W
2% | Class View Ctrl+Shift+C
_ & Code Definition Window  Ctrl+Shift+V
9 Object Browser Ctrl+Alt+)
=] | Output Alt+2
L,:_:l| Property Manager
'@ Resource View Ctrl+Shift+E
¢ | Toolbox Ctrl+Alt+X
Find Results »
Other Windows »
Toolbars >
3 | Full Screen Shift+Alt+Enter
= | Navigate Backward Ctrl+-
=, | Navigate Forward Ctrl+Shift+-
Next Task
Previous Task
Property Pages
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Step 2: In the Resource View Panel, Expand the [Project name].rc file and then expand
the Dialog item to click the plug-in dialog

Resource View - SDK Info  w I1 X
=24 SDK_Info
=3 SDK_Info.rc
-3 Dialog
M= 1DD_SDK_INFO_DIALOG |\ >
- lcon ~SDK_Info.rc - IDD_S... - Dialog| - X
#=-3 Version
LI||||J
o] SDK_Info (=]
=
| TODO: Place dislog controls here. L
<« | Il | E
@ Resource... ‘&@Toolbm: |E, Propert)|| -
-

Step 3: On the Toolbox panel, drag a Button control onto the form

Toolbox + 0 X
B Dialog Editor -
k Painter rl

||:I Button ﬂ
X Check Box “1 8

abl Edit Control —/SDI{_Infu.rc -IDD_S... - Dialug] * X
EB Combo Box T

List Box a = o

(] Group Box | SDK Info [=]
% Radio Button _—-]
Aa Static Text i n " "

Picture Control :

B Horizontal Scroll Bar : TODO: Place dialog contrals here,
B Vertical Scroll Bar

4= Slider Control 4

Resource...

L.
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Step 4: On the Properties panel, type Check the SDK version in the Caption field

Properties - 1 X
IDC_BUTTONI (Button Control) ICeButtonEc -
2=]41 &) # | E

E Appearance
Caption Check the SDK version
Client Edge False
Horizontal Alignmer Default
Modal Frame False
Multiline False
Notify False
Static Edge False
Vertical Alignment Default
E Behavior
Default Button False
Disabled False
Owner Draw False
Visible True
E Misc
(Name) IDC_BUTTOM1 (Button C

rou WWW
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4.4.5. Add the event handling for the control

You have finished the design stage of your application and are at the point when you can start
adding some code to provide the program's functionality.

Step 1: Double-click the button on the form

Im | SDK_Info G

] | | ]
s ChecktheSDE vesion  |m
] [ ] ]

TODO: Flace dialog controls here,

Step 2: Inserting the following code
char sdk_version[32];
TCHAR buf[32];
pac_GetSDKVersion(sdk_version);
pac_AnsiToWideString(sdk_version, buf);

MessageBox(buf,0,MB_OK);

Y YV e N i IV VAN

Hwvoid CSDE InfaoDllg::0nBaClickedButtonl()
{

\J

HfOTODD: Add wour control notification handler code here
char sdk_version[3Z2];

TCHAR buf[3Z2];

pac_GetSDEVersionisdl wersion);
pac_hAns1ToWideString{sdk_version,buf);
MessageBox (huf ,0,MB_OK);

\u_m'-....uuf \b"’ J v

}
Hhkgumwnu”“J“gfrﬂFﬁﬂxxFug”’”““\ujfwwxv““nhfvfw“”“\fh“”‘ﬂvv=—f
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Step 2: Inserting the following code into the header area

#tinclude “PACSDK.h”

B/f SDE_Infallg.cpp @ tmplementation filé}
H y
N n n g
#include "stdafx.h
Finclude "SDE _Infa.k" <;
#Finclude "SDE Infallz. B ¢
#Finclode "PACSDE.L" fE;
S#i1fdef _DEBUG
ﬁww%;w
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4.4.6. Upload the application to VP-1231-CE7

VP-1231-CE7 supports FTP server service. You can upload files to VP-1231-CE7 or download files
from a public FTP server.

Step 1: On the Build menu, and then click Build [Project Name]

File Edit View ijectm Debug Tools Test Window Help
Build Solution F7
Rebuild Solution  Ctrl+Alt+F7
Deploy Solution

Clean Solution
i#¥ Build SDK_Info
Rebuild SDK_Info
Deploy SDK_Info
Clean SDK_Info

Project Only »
Batch Build...
Configuration Manager...
% | Compile Ctrl+F7
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Step 2: Open the browser and type the IP address of VP-1231-CE7

Step 3: Upload the application to VP-1231-CE7

File Edit View Go Favorites ||J][@!
Jstess e {
| N
S0¥_Info
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4.4.7. Execute the application on VP-1231-CE7

After uploading the application to VP-1231-CE7, you can just double-click it on VP-1231-CE7 to

execute it.

% | Check the SDK Wersion | \T

SDK Info
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5. 1/0 Expansion Modules and SDKs Selection

This chapter describes how to select a suitable expansion I/O module and the corresponding SDK

library to be used for developing programs on VP-1231-CE7.

VP-1231-CE7 provides the following I/O expansion buses:

e :

Local I/O modules z
(1-8K/1-87K series I/O modules) |[t =

1/0 Slots

=

ET-7K ET-87Pn
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1. Local I/O Modules (I-8K series and 1-87K series)

VP-1231-CE7 has three expansion slots that can be used to add expansion I/O modules. The
expansion I/0 modules can be divided into two categories: High Profile 1-8K series I/0 modules and

High profile I-87K series I/O modules. The following indicates the appropriate SDK library to be

used for I/0O modules.

> General I-8K/I-87K series I/O modules

Module Native SDK .NET CF SDK
I-8K series PACSDK.dII PACNET.dII
I-87K series PACSDK.dII PACNET.dII
I-8K series with PWM PACSDK_PwWmM.dII PACNET.dII
I-87K series with PWM PACSDK_PWmM.dII PACNET.dII

For full details regarding 1-87K series I/O modules and its demos, please refer to:

http://ftp.icpdas.com/pub/cd/winpac _am335x/demo/vp-x231/pac/applicabled demo for 87k m

odule.pdf

» Specified I-8K series I/O modules

Module Native SDK .NET CF SDK
1-8014W pac_i8014W.dll pac_i8014WNET.dII
I-8017HW pac_i8017HW.dII pac_i8017HWNET.dII
1-8024W pac_i8024W.dll pac_i8024WNET.dII
1-8026W pac_i8026W.dlI pac_i8026WNET.dII
1-8048W pac_i8048W.dlI pac_i8048WNET.dII
I-8050W pac_i8050W.dll pac_i8050WNET.dII
1-8084W pac_i8084W.dlI pac_i8084WNET.dII
1-8088W pac_i8088W.dll pac_i8088WNET.dII
I-8093W pac_i8093W.dl| pac_i8093WNET.dII

[-87088W PACSDK_PWM.dII PACNET.AII

VP-1231-CE7 User Manual, v1.0.0

Copyright © 2016 ICP DAS Co., Ltd. All Rights Reserved.

Page: 103

D4 E-mail: service@icpdas.com



http://ftp.icpdas.com/pub/cd/winpac_am335x/demo/vp-x231/pac/applicabled_demo_for_87k_module.pdf
http://ftp.icpdas.com/pub/cd/winpac_am335x/demo/vp-x231/pac/applicabled_demo_for_87k_module.pdf

2. RS-485 (1-7000 series and M-7000 series)

[-7000, M-7000, RU-87Pn and high profile 1-87K series modules connect to VP-1231-CE7 via a

twisted-pair, multi-drop, 2-wire RS-485 network.

> |-7000 series I/O modules

Module Native SDK .NET CF SDK
[-7000 series PACSDK.dII PACNET.dII
I-7000 series with 1-7088 (D) PACSDK_PWM.dII PACNET.AII

For full details regarding 1-7000 series I/0O modules and its demos, please refer to:
http://ftp.icpdas.com/pub/cd/winpac am335x/demo/vp-x231/pac/applicabled demo for 7k mo
dule.pdf

» M-7000 series I/0 modules

Module Native SDK .NET CF SDK

M-7000 series Modbus Demo Modbus Demo

For more detailed information about M-7000 series modules using Modbus protocol and its demos,
please refer to:
CD:\vp-x231\demo\nModbus\

» RU-87Pn + I-87K series I/O modules

Module Native SDK .NET CF SDK

RU-87Pn+-87K series | PACSDK.dll PACNET.II

» Other Specified 1/0

Native SDK .NET CF SDK

Others PACSDK.dll PACNET.II
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http://ftp.icpdas.com/pub/cd/winpac_am335x/demo/vp-x231/pac/applicabled_demo_for_7k_module.pdf
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3. Ethernet (ET-7000 series and 1-8KE4/8-MTCP)

The Ethernet I/O devices available include ET-7000and I-8KE4/8-MTCP, and support either the
DCON or the Modbus/TCP communication protocol.

Module Native SDK .NET CF SDK
M-7000 series Modbus Demo Modbus Demo
I-8KE4/8-MTCP Modbus Demo Modbus Demo

For more detailed information about ET-7000 and |-8KE4/8-MTCP series modules using
Modbus protocol and its demos, please refer to:
http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/demo/nmodbus/
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6. APl Resources and Demo References

This chapter provides a brief overview of PAC standard APIs and demos that have been designed

for VP-1231-CE7 from the PAC SDK package.

ICP DAS provides a set of demos in different programming languages. You can examine the demo

codes, which includes numerous comments, to familiarize yourself with the PAC APIs. This will

allow developing your own applications quickly by modifying these demo programs.

For full usage information regarding the description, prototype and the arguments of the functions,

please refer to the “PAC Standard APl Manual”

ﬁ PAC Standard API Manual 1.1.1. pdf - Adobe Acrobat Pro

[9l=lE3

WRE REE RN \JEW A
Ber- | RO EORPE| govblh &0 57 - | i
@) @) [« Jr=os | [IR] O | (=) @ [745% -] | [F] B IA @ #HE @ &R
L)|== Bl 2. PAC API Functions .
‘EP B PR - |
; =[P 2.1, System Information API A a=| w: @
2.1.1. pac_GetModuleName
i gzaf.f{iiﬁmmumbm B[P 2.1, System Information APT ~
[P 2,14, pac_GetsDkversion EP 2.1.1. pac_GetModuleMame
o e en [P pac_GetRotaryD
gii; E:E:nga'i"r‘zin [F213 pac_GetSerialMumber E
[P 218, pac_cetmacacdress EP 2.1.4. pac_GetSDEMersion
giiﬁ e [F 2.15. pac_ChangeSlat
Joe e [P 2.16. pac_CheckS0KVersion
P e 2 ez
[P 2.1.16. pac_GetcomMapping [P 2.1.8. pac_GetoSVersion
Sl [P 2.1.8. pac_GetMacaddress
e e . [F 2.1.10. pac_ReBoot 2
[P 2.1.11. Pac_GetCPUversion
[ 2.1.12. Pac_EnableleD
[P 2.1.13. Pac_EnableLEDs
[P 2114, pac_BackwardCompatible
EP 2.1.15. pac_GetEhootyersion
EP 2.1,16, pac_GetComMapping
[P 2117 pac_GetvoduleType
[P 2.1.18. pac_GetPacNetversion
I:P 2.1.19. pac_BuzzerBeep
= W
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6.1. PAC Standard APIs for System Operation

The diagram below shows the set of each system operation API provided in the PACSDK.

[ ! » System Information » Watchdog
| I » Backplane Access >» UART
! » Backlight » Registry
— > Interrupt >» Buzzer
» Memory Access » LED

System Operation
—
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6.1.1. VB.NET Demos for PAC Standard APIs

The PAC SDK includes the following demos that demonstrate the use of the PAC Standard APIs in a
VB.NET language environment.

The following demos can be found on the CD that was provided with the package or by
downloading the latest version from ICP DAS web site.
CD:\vp-x231\Demo\PAC\Vb.net\Standard\
http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/demo/pac/vb.net/standard/

Folder Demo Explanation

Retrieves information about the OS version, CPU

system systeminfo ) }

version, SDK version, etc.

) Retrieves information about the DIP switch, backplane

backplane backplaneinfo

ID and slot count.

Shows how to read/write date values from/to

memory

memoryaccess EEPROM

battery_backup_sram | Shows how to read or write to the battery backup

watchdog watchdog Displays how the watchdog operate
microsd microsd_management | Shows how to enables/disables Micro SD
registry registry Shows how to read/write date values from/to registry
) Shows how to read the name of local I/O modules via
UART diag
UART
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http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/demo/pac/vb.net/standard/

6.1.2. C# Demos for PAC Standard APIs

The PAC SDK includes the following demos that demonstrate the use of the PAC Standard APIs in a

C# language environment.

The following demos can be found on the CD that was provided with the package or by
downloading the latest version from ICP DAS web site.

CD:\ vp-x231\Demo\PAC\C#\Standard\
http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/demo/pac/c%23/standard/

Folder Explanation
buzzer buzzer Shows how to make a simple buzzer beep.
) ) ) ) Retrieves information about the OS version, CPU
Devicelnformation Devicelnformation ) )
version, SDK version, etc.
Retrieves information about the status of the
GetRotaryIlD GetRotaryIlD )
rotary switch
Shows how to read/write data values from/to
Memory Memory
the EEPROM or the backplane of the SRAM
MultiRT MultiRT Shows how to manage the microSD
Writes the managed cod for the rich graphical
RealTimeTest RealTimeTest user interface that does not require true
real-time performance
) ) Shows how to read/write data values from/to
Registry Registry .
the registry
Shows how to read the name of a local I/O
UART UART )
modules via a UART
Displays information about how to operate the
WatchDog WatchDog
watchdog
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http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/demo/pac/c%23/standard/

6.1.3. Visual C++ Demos for PAC Standard APIs

The PAC SDK includes the following demos that demonstrate the use of the PAC Standard APIs in a

Visual C++ language environment.

The following demos can be found on the CD that was provided with the package or by
downloading the latest version from ICP DAS web site.

CD:\ vp-x231\Demo\PAC\Vc2008\Standard\
http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/demo/pac/vc2008/standard/

Folder Explanation
buzzer buzzer Shows how to make a simple buzzer beep.
) ) ) ) Retrieves information about the OS version, CPU
Devicelnformation Devicelnformation ) )
version, SDK version, etc.
Retrieves information about the status of the
GetRotaryIlD GetRotarylD )
rotary switch
Shows how to read/write data values from/to
Memory Memory
the EEPROM or the backplane of the SRAM
MultiRT MultiRT Shows how to manage the microSD
Writes the managed cod for the rich graphical
RealTimeTest RealTimeTest user interface that does not require true
real-time performance
) ) Shows how to read/write data values from/to
Registry Registry .
the registry
Shows how to read the name of a local I/O
UART UART )
modules via a UART
Displays information about how to operate the
WatchDog WatchDog
watchdog
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6.2. PAC Standard APIs for 1/O Expansion

The diagram below shows the types of the PAC IO APIs provided in the PACSDK.

Remote 1/0O Local I/O
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6.2.1.

VB.NET Samples for PAC Standard APIs

The PAC SDK includes the following samples that demonstrate the use of the PAC 10 APIs in a
VB.NET language environment. The following samples can be found on the CD that was provided

with the package or by downloading the latest version from ICP DAS web site.

For VB.NET applications, these demo programs can be obtained from:
CD:\vp-x231\Demo\PAC\Vb.net\IO\
http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/demo/pac/vb.net/io/

Folder Demo ‘ Explanation
S Shows how to retrieve the module names and types which
- plugged in the VP-1231-CE7.
8k di Shows how to read the DI values of DI module.
- This demo program is used by 8K series DI modules.
Shows how to write the DO values to DO module.
8k_do This demo program is used by 8K series DO modules.
8k dio Shows how to read the DI and the DO values of the DIO module.
- This demo program is used by 8K series DIO modules.
e — Shows how to send/receive a command/response application.
- This demo program is used by 87K series modules.
Shows how use UART API and the 10 modules located as slots.
Local 87K _demo
This demo program is used by 87K series modules.
) Shows how to read the Al values of Al module.
87k ai This demo program is used by 87K series Al modules.
87k a0 Shows how to write the AO values to AO module.
- This demo program is used by 87K series AO modules.
e o Shows how to read the DI values of DI module.
- This demo program is used by 87K series DI modules.
87k do Shows how to write the DO values to DO module.
- This demo program is used by 87K series DO modules.
e i Shows how to read the DI and the DO values of the DIO module.
- This demo program is used by 87K series DIO modules.
Shows how to send/receive a command/response application.
7k87k_basic This demo program is used by 7K or 87K series
Remote Al modules which connected through a COM port.
e of Shows how to read the Al values of Al module.
- This demo program is used by 7K or 87K series
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Folder Demo

‘ Explanation
Al modules which connected through a COM port.

7k87k_ao

Shows how to write the AO values to AO module.
This demo program is used by 7K or 87K series
Al modules which connected through a COM port.

7k87k_di

Shows how to read the DI values of DI module.
This demo program is used by 7K or 87K series
Al modules which connected through a COM port.

7k87k_do

Shows how to write the DO values to DO module.
This demo program is used by 7K or 87K series
Al modules which connected through a COM port.

7k87k_dio

Shows how to read the DI and the DO values of the DIO module.
This demo program is used by 7K or 87K series
Al modules which connected through a COM port.
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6.2.2. C# Samples for PAC Standard APIs

The PAC SDK includes the following samples that demonstrate the use of the PAC 10 APIs in a C#
language environment. The following samples can be found on the CD that was provided with the
package or by downloading the latest version from ICP DAS web site.

For C# applications, these demo programs can be obtained from:
CD:\vp-x231\Demo\PAC\C#\IO\
http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/demo/pac/c%23/io/

Folder Demo ‘ Explanation
S Shows how to retrieve the module names and types which
- plugged in the VP-1231-CE7.
8k di Shows how to read the DI values of DI module.
- This demo program is used by 8K series DI modules.
Shows how to write the DO values to DO module.
8k_do This demo program is used by 8K series DO modules.
8k dio Shows how to read the DI and the DO values of the DIO module.
- This demo program is used by 8K series DIO modules.
e — Shows how to send/receive a command/response application.
- This demo program is used by 87K series modules.
Shows how use UART API and the 10 modules located as slots.
Local 87K _demo
This demo program is used by 87K series modules.
) Shows how to read the Al values of Al module.
87k ai This demo program is used by 87K series Al modules.
87k a0 Shows how to write the AO values to AO module.
- This demo program is used by 87K series AO modules.
e o Shows how to read the DI values of DI module.
- This demo program is used by 87K series DI modules.
87k do Shows how to write the DO values to DO module.
- This demo program is used by 87K series DO modules.
e i Shows how to read the DI and the DO values of the DIO module.
- This demo program is used by 87K series DIO modules.
Shows how to send/receive a command/response application.
7k87k_basic This demo program is used by 7K or 87K series
Remote Al modules which connected through a COM port.
Shows how to read the Al values of Al module.
7k87k_ai
- This demo program is used by 7K or 87K series
VP-1231-CE7 User Manual, v1.0.0 Page: 114

Copyright © 2016 ICP DAS Co., Ltd. All Rights Reserved. E-mail: service@icpdas.com



http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/demo/pac/c%23/io/

Folder Demo

‘ Explanation
Al modules which connected through a COM port.

7k87k_ao

Shows how to write the AO values to AO module.
This demo program is used by 7K or 87K series
Al modules which connected through a COM port.

7k87k_di

Shows how to read the DI values of DI module.
This demo program is used by 7K or 87K series
Al modules which connected through a COM port.

7k87k_do

Shows how to write the DO values to DO module.
This demo program is used by 7K or 87K series
Al modules which connected through a COM port.

7k87k_dio

Shows how to read the DI and the DO values of the DIO module.
This demo program is used by 7K or 87K series
Al modules which connected through a COM port.
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6.2.3.

Visual C++ Samples for PAC Standard APIs

The PAC SDK includes the following samples that demonstrate the use of the PAC 10 APIs in a
Visual C++ language environment. The following samples can be found on the CD that was

provided with the package or by downloading the latest version from ICP DAS web site.

For Visual C++ applications, these demo programs can be obtained from:
CD:\vp-x231\Demo\PAC\Vc2008\I0\
http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/demo/pac/vc2008/io/

Folder Demo ‘ Explanation
S Shows how to retrieve the module names and types which
- plugged in the VP-1231-CE7.
8k di Shows how to read the DI values of DI module.
- This demo program is used by 8K series DI modules.
Shows how to write the DO values to DO module.
8k_do This demo program is used by 8K series DO modules.
8k dio Shows how to read the DI and the DO values of the DIO module.
- This demo program is used by 8K series DIO modules.
e — Shows how to send/receive a command/response application.
- This demo program is used by 87K series modules.
Shows how use UART API and the |0 modules located as slots.
Local 87K _demo
This demo program is used by 87K series modules.
) Shows how to read the Al values of Al module.
87k ai This demo program is used by 87K series Al modules.
87k a0 Shows how to write the AO values to AO module.
- This demo program is used by 87K series AO modules.
e o Shows how to read the DI values of DI module.
- This demo program is used by 87K series DI modules.
87k do Shows how to write the DO values to DO module.
- This demo program is used by 87K series DO modules.
e i Shows how to read the DI and the DO values of the DIO module.
- This demo program is used by 87K series DIO modules.
Shows how to send/receive a command/response application.
7k87k_basic This demo program is used by 7K or 87K series
Remote Al modules which connected through a COM port.
Shows how to read the Al values of Al module.
7k87k_ai
- This demo program is used by 7K or 87K series
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Folder Demo

‘ Explanation
Al modules which connected through a COM port.

7k87k_ao

Shows how to write the AO values to AO module.
This demo program is used by 7K or 87K series
Al modules which connected through a COM port.

7k87k_di

Shows how to read the DI values of DI module.
This demo program is used by 7K or 87K series
Al modules which connected through a COM port.

7k87k_do

Shows how to write the DO values to DO module.
This demo program is used by 7K or 87K series
Al modules which connected through a COM port.

7k87k_dio

Shows how to read the DI and the DO values of the DIO module.
This demo program is used by 7K or 87K series
Al modules which connected through a COM port.
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7. VP-1231-CE7 Updates

This chapter provides a guided tour that demonstrates the steps needed to update the
VP-1231-CE7 OS and SDKs.

ICP DAS will continue to add additional features to VP-1231-CE7 SDK and OS in the future, so we
advise you to periodically check the ICP DAS web site for the latest updates.

The file location of the OS and SDK
Both the files of OS updates and SDK updates can be found on the CD that was provided with the

package or by downloading the latest version from ICP DAS web site.

CD:\vp-x231\
http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/

> The files of OS updates

update_from_Micro_SD

> The files of SDK updates
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7.1. OS Updates

The latest version of the VP-1231-CE7 OS image can be found separately on the CD that was

provided with the package or by downloading the latest version from ICP DAS web site.

CD:\vp-x231\
http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/

OS_Image
VP-123x
update_from_Micro_SD

update_from_file

There are two ways to update the OS:

OS image

update_from_Eshell_

update_from _file or_Micro_SD

1. OS updates from eshell (Please refer to section 7.1.1)
(We recommend that you use this one for more quicker and easier to update)

2. OS updates from micro_SD (Please refer to section 7.1.2)
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7.1.1. OS Updates from Eshell

By default, the OS update is updated via a LAN.
Before updating the OS, make sure the LAN is
connected to PC.

Step 1: Get the latest version of the installation package file and then unzip it
The latest version of the installation package file can be found from ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac am335x/vp-x231/os image/vp-123x/update f

rom eshell or micro sd\

Step 2: Run the registry clear.exe

The registry.exe can be found on the CD that was provided with the package or by

downloading the latest version from ICP DAS web site.

CD:\VP-x231\PC_Tools\Eshell
http://ftp.icpdas.com/pub/cd/winpac am335x/vp-x231/pc tools/eshell/

Step 3: Place the rotary switch in position 3, OS update mode
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Step 4: Run the ESHELL.exe, and then restart the VP-1231-CE7-CE7

The ESHELL.exe can be found on the CD that was provided with the
package or by downloading the latest version from ICP DAS web site. ESHELL

CD:\VP-x231\PC_Tools\Eshell
http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/pc tools/eshell/

Step 5: Select the device which you want to update the OS image, and then click OK

Select the device name which you want to update the OS image from the list.

Select Device

Enter Device Mame:

[WINPAC
Or Select Fram the List

LI X]

Cancel

Reset devices to
automatically put
names on the
izt

Step 6: Select the latest version of the OS image file

Look inc | (£ WPtha S0 s | A04_ml

~:. U NE binf
iy Riecent

[hocuments

x| «® ek -

— W5 W ywsdt Wosdews O Dabag Bl - TF_S5000 QR Tod T/l & Cimaged cop 00 _oo MI0T_umape'ny 70w s [ =]
[a [ Bl ook fdoes Yew fey

Deskiop B &F A ': |

OF_NANRE | BEEIasaer Berulias 0,0, IFD 191,050, MRC; BReETF ek

Srwnleading " ViR avod_ PVHaFE0 napdastvp - T E_crt NS imegeep - FluTapdate_fron_[nbe 1m0

_,_.--‘III 'd:?l-:-tll:l: ::.ﬂ_l-u::':m Dtherast, .,
My Drocurments
My Computes i 3
My File narne: NE BIN
Filees of bypes: HE Images (*
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Step 7: Once the procedure is completed, the “Warning !” dialog box will appear as
below shown, then turn the rotary switch in position 0, normal mode

YWarning

"'_n.. Reboot this device right nowy |

L Flease turn the rotary switch to 0 - normal

Step 8: Click the OK button

E_

=
Warning =
"'_n,‘ Reboot this device right nowy | ‘
L Flease turn the rotary switch to 0 - normal

Step 9: Check the OS version

Run the PAC Utility, and then select the Device Information tab to check the current

OS version.
X
I ~
PAC_Utility
PAC Utility [1.2.1.4] |0
[General I General2 IDispIay I IF Config INetwork |DewceInf0rmat|Dn| Auto Execution I Fotary EXML
Slot 1 |:| Module(CPU) Type: | |
Stz [ ] Serial Number: [p1-82-4D-06-18-00-00-D8 |
Slot 3: l:l Backplane Yersion: | |
Slot 4: |:| CPU Yersion: [tooa |
Slot 5: |:| 05 Yersion: [10.11, 2msa0m0 09536 |
Sote: [ ]  Ebootversion: [12.10, 2msa0/22 16:260 |
Slot 7: |:| {NET CF Yarsion: |2.5.7238.00 |
SOL CE version: [35.8154.0 |
PACSDK Version: [4.2.34 |
CPU Temperature: | |
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7.1.2. OS updates using micro_SD

The microSD card can be used to reinstall the VP-1231-CE7 OS image to factory default settings in
the event of the VP-1231-CE7 failure.

Step 1: Get the latest version of the installation package file, then unzip the file, and then
copy them to microSD card

The latest version of the installation package file can be found from ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac am335x/vp-x231/os image/vp-123x/update f

rom eshell or micro sd\

& WP523x 20140821 Ver.1.0.0.4 ml

File Edit “ew Favortes Tools Help

eBack T &4 lm ;]SEarch I Folders

acidress |3 Ciupdate_from_Eshell_or_Micro_STAWPS23x_20140821

[ ] EBOOTHD nbbi [ j EE0OTSD b0
= ac it
8¥B 9 KB

[ KLDRNAND nb0 [ HLDRSD nbl

MR \EI S

— icro
-

Adapter

Step 2: Plug the microSD card into microSD slot

A

¥ o

icro
>
Adapter

VP-1231-CE7 User Manual, v1.0.0 Page: 123

Copyright © 2016 ICP DAS Co., Ltd. All Rights Reserved. <] E-mail: service@icpdas.com


http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/os_image/vp-123x/update_from_eshell_or_micro_sd/
http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/os_image/vp-123x/update_from_eshell_or_micro_sd/

Step 3: Turn the rotary swi
OS update mode

PAC Utility [1.2.1.4]

iﬁﬁ Help

tch in position 5,

1)

-

Save
Save and Reboot
Reboot

Restore Litility Default Settings
Exit

5
onfig I Metwark I,“

\,

Step 4: Reboot the VP-1231-CE7

Y
o
3
Y

’

Step 5: Wait a few minutes for the following
desktop to be displayed

—
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Step 6: Turn the rotary switch in position 0, normal mode
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Step 7: Reboot the VP-1231-CE7

PAC Utility [1.2.1.4]

iﬁE Help -

i
Save %‘l’
Save and Reboot £l | EEE 7

Reboot

Restore Utility Default Settings
Exit

J U%’J\u“‘""#“\

Step 8: Check the OS version

Run the PAC Utility, and then select the Device Information tab to check the current

OS version.
-
PAC_Utility
PAC Utility [1.2.1.4] M [=]
| General | Generalz | Display | 1P Config | Metwork || Device Infarmation | Autn Execution I Rotary Exe (| |
Slot 1: l:l Maodule(CPL) Type: | |
Sit2: [ ] Serial Number: |o1-62-4p-06-18-00-00-D8. |
Slat 3: |:| Backplane Version: | |
sot4: [ ] cPUversion: [tooa |
Sots: [ ] oS versin: [10.1.1, 2015/10/30 09:365 |
Slat &: |:| Eboat Yersion: [12.1.0, 201540722 16:26:0 |
Sit7: [ ] MNETCF Version: [z5.7338.00 |
SQL CE Yersion: [35.8154.0 |
PACSDK Yersion: [433.4 |
CPU Temperature: | |
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7.2. SDK Updates

SDK update is a part of the VP-1231-CE7 update services to provide additional and more efficient
features and functionality for VP-1231-CE7 operating system.

The SDK update files can be found separately on the CD that was provided with the package or by
downloading the latest version from ICP DAS web site.

CD:\vp-x231\SDK\
http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/sdk/

— .
— T
— .
=
—
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7.2.1. SDK Updates for VB.NET or C#

The SDK can be updated by changing the SDK file.

Step 1: Get the latest version of the PACNET.dII file

The latest version of the PACNET.dII file can be obtained from ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/sdk/pacnet/

Step 2: Copy the latest version of PACNet.dll file to PC and VP-1231-CE7
The PACNET.dII file on PC can be placed anywhere only the solution can reference it.

The PACNET.dII file on VP-1231-CE7 is located at the same directory as the .exe file.
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7.2.2. SDK Updates for VB.NET or Visual C++

The SDK can be updated by changing the SDK file.

Step 1: Get the latest version of the VC++ components
The latest version of the VC++ components can be obtained from:

http://ftp.icpdas.com/pub/cd/winpac am335x/vp-x231/sdk/pacsdk/

Step 2: Copy the latest version of header files and libraries to PC
The header files are located at:
C:\Program Files\Windows CE Tools\SDKs\AM335x_WINCE7_SDK\Include\Armv4i
The libraries are located at:

C:\Program Files\Windows CE Tools\SDKs\AM335x_WINCE7_SDK\Lib\ARMv4|

Step 3: Copy the latest version of DLL files to VP-1231-CE7
The DLL files are located at:

\System_Disk\ICPDAS\System
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8. ViewPAC Download Center

This chapter provides a brief introduction of the ViewPAC download center.

ViewPAC has a download center where you can access the latest version of the software, tools,

demo programs, and related information.

The ViewPAC Download Center can be found at:
http://www.icpdas.com/root/support/download/pac/vp-x23x-ce7/vp-x23x-ce7 download os ima

ges.html

VP-x23x Download Center

Note:
When you download the software programs, you should notice if the programs conform to your

machine. Bsfore you download any program, please read the notes of each onling program first to
avoid the confusad situation.

-

05 images f SDK TUtiIit'_.r & TDD|5T Demo T Documents TSystem Disk T FAQ

Note:
Before you download the software programs, you should notice if the programs are compatible to
yvour machine. Please read the notes first in each chapter you want before download programs.

Note: User can chack the OS image version by PAC Utility -» System Information-> OS version

VP-123x OS Image

Version: 1.0.1.1 (Releasad at Dec. 2015)
0S image update by Micro_SD (copy file to Micro_SD of VP-1231)

VP123x_20151216_wver.1.0.1.1_ml.zip (Multi-lingual)

0S image update from eshell
VP123x_ 20151216, wver.1.0.1.1_ml.zip (Multi-lingual)

-fw"( \w—\n// v—\—rvxaf/bwwr\\/

VP-1231-CE7 User Manual, v1.0.0 Page: 129

Copyright © 2016 ICP DAS Co., Ltd. All Rights Reserved. <] E-mail: service@icpdas.com



Tips & How to

This chapter provides tips and a guided tour on using and maintaining the VP-1231-CE7.
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A. 1-8K and I-87K 1/0 Modules

There are 3 slots to expand local I/O. And the I/O modules can be parallel bus type (high profile
I-8K series) and serial bus type (high profile I-87K series).

The difference between them is as follows:

| Functions I-8K Series I-87K Series
Communication interface Parallel bus Serial bus
Protocol - DCON
Communication speed Fast Slow
DI latched function - Yes
Counter input (for digital input module) - Yes (100 Hz)
Power on value - Yes
Safe value - Yes
Programmable slew-rate for AO module - Yes
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B. How to Change the Battery

RTC and SRAM data is retained by two Li batteries, which can supply continuous power to the 512
KB SRAM to ensure that the data is retained for 5 years. The dual-battery design has the added
function of preventing data from being lost while replacing the battery.

The following figures show the location of the two batteries installed in the ViewPAC.

Battery 2 s
Battery 1

To checking the current battery power:

1. Run the PAC utility and check the Battery1 and Battery2 fields that display the current
status of each battery. Refer to Section 3.1.3. PAC Utility - Property Tab - General for more
details. If the power level for either of the batteries is low, both should be replaced.

2. When programming this, call the pac_GetBatteryLevel() API function in the PACSDK.dII to
check whether the battery power is low. When the power for either of the batteries is low,
it’'s recommended that the battery is replaced immediately, otherwise the data on the
SRAM may be lost or RTC time will be reset.

Tips & Warnings

A The battery initial voltage should be around 2.8 V to 3.0 V. When lower than
2.1V, the PAC Utility will show the low power warning. When lower than 1.5
V, the data in the RTC (real time clock) and 512 KB SDRAM will be lost.
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To replace the battery without losing data:

1. Power off the ViewPAC.

2. Remove the slot cover and 1/0 socket inserted into the slot.

3. First, remove the battery that is running low on power from the battery holder.
4. Insert a new battery.

5. Remove the other battery.

6. Insert a new battery.

Tips & Warnings

A 1. If the battery power for only one of the two batteries is low, you can use
this method to replace the battery so as to prevent data from being lost. (In
the circuit design for the ViewPAC series, when the power for one of the
batteries is low, it will automatically switch to the other one to ensure
continued battery power)

2. If both batteries have run out of power, the data will be lost, even if this
method is used to replace the batteries.

To replace the battery 1/2:

To back up the SRAM data using the backup utility before replacing the battery. Refer to Section
“Using the Backup Utility to back up the settings and files” to back up and restore the SRAM data.

1. Run the backup utility to back up the SRAM data.

2. Power off the ViewPAC.

3. Remove the slot cover and I/O socket inserted into the slot.

4. Remove both batteries from their respective holders.

5. Insert a new battery.

6. Power on the ViewPAC.

7. Run the backup utility to restore the SRAM data.

8. Set the RTC time.

VP-1231-CE7 User Manual, v1.0.0 Page: 133

Copyright © 2016 ICP DAS Co., Ltd. All Rights Reserved. E-mail: service@icpdas.com



C. How to Online Debug the VP-1231-CE7 Program

Here are step by step instructions on how to online debug the VP-1231-CE7 program.

Tips & Warnings

A Before starting online debug the VP-1231-CE7 program, make sure that the
VP-1231-CE7 SDK has been installed correctly.

For more information on how to install the VP-1231-CE7 SDK, please refer to

4.1.2. Installing the VP-1231-CE7 SDK.

Step 1: Copy the following files to the \System_Disk\icpdas\system on the VP-1231-CE7

By default, these files are located on the development computer at C:\Program

Files\Common Files\Microsoft Shared\CoreCon\1.0\Target\wce400\<CPU>.

Step 2: Run the ConmanClient2.exe and then CMAccept.exe on the VP-1231-CE7

clientshutdown.exe

CMAccept.exe

ConmanClient2.exe

eDbgTL.dll

TcpConnectionA.dll

mfc20ipn

pacnet

L)

atlso

)

rnfcB0kor

)

mfc90ita

)

pacsdk

I]]ﬂgldrezs | WSystermn_Diskicpdasisysten

fie

autoinit

)

rnfce0u

)

mfc90jpn

)

pacsdk_wm

@] (%
mfcB0chs  mfcB0cht
@) (%
mfc80ud  mfc90chs
@] (%
rfc90kar rnfc90u
Iy

eDbgTL
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mfc20ud
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Step 3: On the Tools menu, click the Options

File Edit View Project Build Debug Test Window Help
Bl -E-EH O % DR v‘ =k Attach to Process.. Ctrl+Alt+P

| AM335x_WINCE7_SDK AF v | 85 [ 42 | ®4 Device Security Manager...
Q; Connect to Device...

Qevice BTG \RRBGE .~ f o

External Tools...

Import and Export Settings...

Options...

Step 4: In the left pane, expand Device Tools node and select Devices

Step 5: In the Show devices for platform:, select AM335x_WINCE7_SDK and then click
Properties

Options

Environment
Projects and Solutions
Source Control
Text Editor
Database Tools
Debugging
Device Tools

General

Devices

Form Factors
HTML Designer
Office Tools
Test Tools
Text Templating
Windows Forms Designer
Workflow Designer

8how devices for platform:

| AM335x_WINCE7_SDK

AM335x WINCE/_SUK ARMYV S Uevice

N
e S5

Default device:

AM335x_WINCE7_SDK ARMV7 Device
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Step 6: Click the Configure...

f |
AM335x_WINCE7_SDK ARMV7 Device Properties | LE'] 28 )

Default output location on device:

Transport: \l

Configure... ‘ )

/

|TCP Connect Transport

Bootstrapper:

\

|ActiveSync Startup Provider - Configure...

Detect when device is disconnected

QK ‘ ‘ Cancel

Step 7: Select the Use specific IP address:, and then type the IP address of VP-1231-CE7

Configure TCP/IP Transport m
-

"] Use fixed port number: 5655

Device IP address

(7) Obtain utomatically using ActiveSync

@ Use specific IP address:

l‘w%l / -

OK ] ‘ Cancel
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Step 8: Click the OK, and then click OK to end the dialog

AM335x_WINCE7_SDK ARMV7 Device Properties P

e ——— i o—

Default output location on device:

Transport: i
[TCP Connect Transport v l l Configure... l
Bootstrapper:

[ActiveSync Startup Provider '] ‘ Configure.. ‘

Detect when device is disconnected

Options

> Environment Show devices for platform:
» Projects and Solutions

» Source Control

» Text Editor

» Database Tools

» Debugging

a Device Tools
General Rename...

| AM335x_WINCE7_SDK -

Devices:

AM335x_ WINCE7_SDK ARMV7 Device

Save As...

| Devices|

Form Factors
> HTML Designer :
» Office Tools Properties...
» Test Tools [
» Text Templating
> Windows Forms Designer |
» Workflow Designer [
Default device:

AM335x_WINCE7_SDK ARMV7 Device j |

Delete

il
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Step 9: On the Tools menu, click the Connect to Device...

File Edit View Project Build Debug |Tools | Test Window Help
|_—i Attach to Process... Ctrl+Alt+P

ce Security Manager...
8, Connect to Device..

Device Emulator Manager...

Connect to Database...

Connect to Server...

Code Snippets Manager.. Ctrl+K, Ctrl+B

Step 10: Wait for the connection to be established

Connecting..

'@:l

To 'AM335x_WINCE7_SDK ARMV7 Device'

Connection succeeded.

Tips & Warnings

A If the connection fails, as shown below, please repeat the step 2 to step 9 to
try it again.

Connecting...

2 :

To 'AM335x WINCE7_SDK ARMVT Device'
Connection failed. ActiveSync bootstrap initialization

failed.
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D. How to Automatically Synchronize VP-1231-CE7 Clock with an
Internet Time Server

The clock on the VP-1231-CE7 can be synchronized with an internet time server. This means that
the clock is updated to match the clock on the time server, which can help ensure that the time on
the VP-1231-CE7 is accurate. Here are step by step instructions on how to synchronize the clock on
the VP-1231-CE7 with an Internet time server.

Step 1: Run the PAC Utility

~/k

PAC_Utility

Step 2: On the General tab, press Configure button

PAC Utility [1.2.1.4]

File Help

General | General2 I Display IIF' Config I Metwark I Device Information I.-'l'-.ub] Execution I Rotary Exg 4| ¥

Welcome o use PAC Utility
This tool will help you easy o
Lse PAC CE series,

PAC Utilit Y Task Bar setting:
[ suto Hide

[ always On Top

HIVE Reqistry:
) AUt Save Tao Flash (Default)

{ ) Maunal Save Tao Flash

Backplane Battery [7] Enable sutarun in plugging USE Disk
Batteryl : OK Battery2 : OK [] Enable sutarun in plugging Micro SD
RTC Battery

e

Configure the synchronization with a time seiver | Configure | | %cklight Setting
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Step 3: Select the domain name from the Server drop-down list, and then enter a value
in the Autoupdate Frequency field

Step 4: Check the Automatically synchronize with an internet time server check box

Stepl: Server: I tock, usno.navy., mil El

Step2: autoupdate Freguency:  |20160 | minute

Step3:

Autarnatically synchronize with an internet time server

Lipdats Mow

Step 4:Go to "File" -->"Save and Reboot" 1o enable
driver

ALt update running

Step 5: On the File menu, click Save and Reboot

PAC Utility [1.2.1.4]
F=8 Help

Save and Reboot
Reboot

3
3
_,."
.
Restore Utility Default Settings {
A

Step 6: The VP-1231-CE7 will automatically synchronize with an internet time server

regularly
Stepl: Server: |b:nck.usnn:u.naw.mil El
Step 7: Click the Update Now button to
P _p StepZ: Autoupdate Freguency: rinLte
synchronize VP-1231-CE7 clock .
immediately P
@ Zaiomatically synchronize with an internet time serves
| Lipdate Mo
Steprswcatn "File" --="Save and Reboot" io enabls
driver
Auto update running
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E. How to Control the User Account Control in VP-1231-CE7

User Account Control is a security feature that helps prevent unauthorized system changes to the
VP-1231-CE7.
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E.1. How to Create a User Account

Here are step by step instructions on how to add a user account.

Step 1: Run the PAC Utility

\../L

PAC_Utility

Step 2: On the Login tab of the Network tab, click Login tab, type the User Name and
Password, and then click Add button

PAC Utility [1.2.2.0] !

IGeneraI I General? I Display IIF' Config | Metwork |Device Infor mation I.&uh: Execution IRDtary E}{d 1 I 4

IAccess| Login |

User Mame Password

ficroes N |  4od || Delet

User narme I Passwiord I
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Step 3: The user has been added to the allowed under the remote login and included in
the following list

PAC Utility [1.2.2.0] !

[General IGeneraI2 IDispIay IIP Config | Metwork |Device Infor mation I Auto Execution IRDtary E}{EI i I »

[ ACCEsS | Login |

Lizar Marme Password

ficP as N | add | Delete

User narme | Password

Step 4: On the File menu, click Save and Reboot for changes to take effect
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E.2. How to Use Telnet to Remote Login the ViewPAC from PC

Here are step by step instructions on how to use telnet to remote login the ViewPAC from PC.

Step 1: On the PC, open a MS-DOS command prompt

Type the

docurnent, < yau,
Brograms Y f
a [B]al="g} |n:n‘u:| EI
i? Faworites S0
D Documents  *
[F Settings v Ok Cancel Bronwse, ..

Step 2: At the command prompt, type “telnet (IP address)”

o CAWINDOWSsystem32vcmd exe

C:“Documents and Settings“MWindows>telnet 18.1.8.31
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Step 3: The connection has been set up, and then type the name and password

ey Telnet 10.1.0031

ilelcome to the Windows CE Telnet Service on Compact

login: ICPDAS
Paszword:

Step 4: The remote login has been completed

o Telnet 10.1.0.31

llelcome to the Windows CE Telnet Service on Compact

login: ICPDAS
FPazsword:

VP-1231-CE7 User Manual, v1.0.0 Page: 145

Copyright © 2016 ICP DAS Co., Ltd. All Rights Reserved. <] E-mail: service@icpdas.com




E.3. How to Remove a User Account from the Login List

Here are step by step instructions on how to remote the user from the login list.

Step 1: Click a user from the list which you want to remove, and the user will display in
the field, and then press Delete to delete the user from the login list

PAC Utility [1.2.2.0] !
File Help

[General General2 IDispIa\; IIF' Config | Metwork |Device Infor mation Iﬁuh: Execution IRotary Exe 1| P

[ Access | Login |

User Marme Password

ice Das | [ | Add | Delete

User name | Password

Step 2: On the File menu, click Save and Reboot for changes to take effect
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F. How to Use the Services Tool

The services tool can help you turn on, turn off and monitor the WinCE services.

Step 1: On the PC, open a MS-DOS command prompt

Prograrns
ﬂf Favarites
EI Docurnents  *

@ Settings " (04 Cancel Eronwse, .,
™,
Step 2: List all services
[Syntax] services list
File Edit Help
Pocket CMD» w 5.0
“Wr o saerwices list
NF0: Ox000320110 NOTIFY.D11 Purnriiricg
HTEPO: Qx000321570 HTTPD . I'LL Purnmingg
CRI:O: Qx0002207%70 credswo_dll Pomiriirey
T - Qx00032&790 MEMOD . D11 Off
OBX0O: Qx00032&bZ0 QBEEXSrVr.dll Dff
FTPO: Qx000327770 FTPD. D11 Punmirio
TELO: Qx00037acO TELHETD.I'11 Punmirnco
sMEO: Ox0002c2e0 smhsarwer. dll Prgariiy
MNTEPO: Ox000zZ£££0 timesyo.dll P
ve |
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Step 3: Type the commands to configure service
[Syntax] services stop <services name>
For example, turn on the “FTP” service:

services stop FTPO:

File Edit Help

Pocket CMD v 5.0
\> serwvices stop FTPO:
\> serwvices list

FYO: 0x00030110 NOTIFY.D1ll Running
TPO: 0x00031570 HTTPD.DLL Running
CRDO: 0x00032070 credsve.dll Running
Ql: 0x000367390 MSHQD.D11 Off
0x00036b20 OBEXSrVr.dll Off
TPO: 0x00037770 FTPD.D11l Off
TELO: 0x00027acO TELNETD.D1l1l Running
SMBO: 0x0003c3e0 subserver.dll Runmindg
INTPO: Ox0003£££0 timesve.dll RPunnin
\ >
Tips & Warnings

A For more information about using services tool, just type “services help”

| File Edit Help |

Pocket CMD v 5.0

> services help

Commands:
help - print this text
list - lists loaded serwices
load <serwvice name> = activates a service that i=
stop <service instancer* stops/pauses a service (4
Start <service instance> = sStarcs/resumes & sServi
refresh <service instance*> - causes service to ref:
unload <serwvice instance> - causes sService o be u
register <“service name>* - service will be automar:

eboot

unregister <service name> - service will not he =u
mext reboot

command <service name> [argl argZ ...] - send serv
o service

help <service name> - get information on what serv
are supported

“service name> - service's name in the registry
<service instance’> - particular instantiation (1

Flags:
-f <file name>
-£ filent
-d output to debugger
> 1
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G. Revision History

This chapter provides revision history information to this document.

The table below shows the revision history.

Revision Description
1.0.0 December 2015 Initial issue
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